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Safety

The manufacturer has designed this equipment to be safe when operated using the procedures 
detailed in this manual. The user must not use this equipment for any other purpose than that 
stated. Do not apply values greater than the maximum value stated.

This manual contains operating and safety instructions, which must be followed to ensure the safe 
operation and to maintain the equipment in a safe condition. The safety instructions are either 
warnings or cautions issued to protect the user and the equipment from injury or damage. Use 
qualified personnel and good engineering practice for all procedures in this manual. 

Electrical Safety

The instrument is designed to be completely safe when used with options and accessories supplied 
by the manufacturer for use with the instrument. The input power supply voltage limits are 90 to 
260 V AC, 50/60Hz. 

Pressure Safety

DO NOT permit pressures greater than the safe working pressure to be applied to the instrument. 
The specified safe working pressure is 1 barg (14.5 psig). 

Toxic Materials

The use of hazardous materials in the construction of this instrument has been minimized. During 
normal operation it is not possible for the user to come into contact with any hazardous substance 
which might be employed in the construction of the instrument. Care should, however, be exercised 
during maintenance and the disposal of certain parts. 

Repair and Maintenance

The instrument must be maintained either by the manufacturer or an accredited service agent. Refer 
to www.michell.com for details of Michell Instruments’ worldwide offices contact information. 

Calibration

The recommended calibration interval is one month for analyzers in continuous use (on-line 
measurement), but this can vary dependent on accuracy requirements and location of unit.

For analyzers that are only used for spot checking a reference gas should be passed through the unit 
each time before use, this can be ambient air for Zirconia sensors.

The instrument can be returned to the manufacturer, Michell Instruments, or one of their accredited 
service agents for re-calibration (go to www.michell.com for contact information). 

Safety Conformity

This product meets the essential protection requirements of the relevant EU directives. 
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Abbreviations

The following abbreviations may or may not be used in this manual:

AC alternating current
°C  degrees Celsius
°F  degrees Fahrenheit
HMI human machine interface
l/min liters per minute
kg  kilogram(s) 
LCD liquid crystal display
lb  pound
mA  milliampere
mm millimeter
N/C normally closed
N/O normally open
PC personal computer
ppm parts per million
RS232 serial data transmission standard
V  Volts
W Watt
% percentage 
" inch
Ω ohm

Warnings

The following general warning is applicable to this instrument. It is repeated in the text 
in the appropriate locations.

! Where this hazard warning symbol appears in the following 
sections, it is used to indicate areas where potentially hazardous 

operations need to be carried out.
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INTRODUCTION

1 INTRODUCTION

The XGA301 Industrial Gas Analyzer is designed predominantly to measure oxygen. 
It can also be specified with one or two additional sensors from four measurement 
technologies. Pressure and temperature sensors are either included or options, 
dependent on configurations.

Available measurements are:

• O2

• H2O (moisture/dew point)

• CH4

• CO

• CO2

• Pressure

• Temperature

With its lightweight carry handle and retractable feet, it is easy to move from bench to 
bench or simply to a storage shelf in between usage.

There are three chassis available:

• XGA301A1 - can be fitted with a single sensor only with gas ports on the 
front or rear panel. Alternatively the unit can be supplied with one or two 
flying lead sensors (O2 or O2+Pressure)

• XGA301A2 - has a larger case and can be supplied with either one or two 
sensors. The analyzer has a flow meter with needle valve as standard.

• XGA301A3 - has the same chassis as the XGA301A2, but has a 4-line 
display and is supplied with up to three sensors.

1.1 Features

• Single, dual or triple gas measurement options available

• Zirconium-oxide, electrochemical, infra-red and ceramic impedance 
technologies available

• Easy calibration procedure through HMI

• Powerful variable speed diaphragm pump fitted for sampling the gas

• XGA301A1 & A2 - back-lit LCD display (16 x 2 characters)

• XGA301A3 - back-lit LCD display (20 x 4 characters) 

• RS232, 0 to 10 V (A1 model) or 0 to 5 V (A2 and A3 model) and 4-20 mA 
current loop outputs (both fully programmable)

• Fully programmable alarm circuits

• Full data-logging software accessed via RS232 connection to a PC

• Password protection available

• Optional printer attachment
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2 OPERATION

!

PRECAUTIONS

The unit should not be exposed to extreme temperatures < -5°C 
or > +50°C (< +23°F or > +122°F)

 
Normal operating temperature is +5 to +35°C (+41°F or +95°F) 

Avoid direct sunlight 

Do not use liquid cleaners, aerosols or solvents to clean the case 

Use a damp cloth for cleaning 

Do not use this equipment near water 

Avoid touching the LCD display as this may cause permanent 
damage 

Make sure the rear ventilation slots and the fan on the rear 
panel are free of obstruction

!
There are no user-serviceable parts in this unit 

Do not attempt to repair the analyzer 
 

Refer all servicing to qualified Michell Instruments' personnel

!
This unit is NOT designed for use in life support systems

No responsibility can be held for injury or loss of life caused by 
inappropriate use of this equipment

! The unit is not suitable for enriched oxygen samples (O2 > 21%)

!
Additional care must be taken when using toxic or flammable 

gases such as carbon monoxide (CO) and methane (CH4). 

Carbon monoxide is an extremely poisonous gas and is also 
flammable in high concentrations.  Make sure that the gas 

outlet is always connected to an outside vent.  It is strongly 
recommended that a personal CO safety alarm is always used 

when operating this equipment in order to protect the operator.
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2.1 Front Panel

 

Figure 1 XGA301A1 Front Panel

2.2 Rear Panel

7

106

8 9    

Figure 2 XGA301 Rear Panel (A1 & A3)

1 LCD
2 Gas In
3 Gas Out
4 Power switch
5 Keypad
6 Terminal block
7 Power socket
8 Cooling fan
9 Pump On/Off switch
10 'D' type socket
11 Pressure relief vent
12 Thermocouple

2.3 Menu System

All of the user-programmable functions are accessed via a menu system which is 
controlled using the front panel keypad (Figure 1 (5)). To access the menu press the 
ENT key. To escape and return to the operating screen press the ESC key at any time. 
The menu system flow chart is shown below.
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2.3.1 Menu Structure

The Menu Structure below is an example only. The actual menu will vary depending on 
how the analyzer is configured.

095E+05ppm   O2
0.0mbar

1. Calibrate Calib: O2 HighENT

ENT

2.095E+05ppmENT 2.087E+05ppmENT 2.095E+05ppm O2
O2 calibrated

Calib: O2 Middle 1.013E+03ppmENT 1.020E+03ppm O2ENT 1.030E_03ppm O2
O2 calibrated

Edit O2 HIGH Enter for 2s to calibrate Displays for 1.5s

Edit O2 MIDDLE Enter for 2s to calibrate Displays for 1.5s

3. Set Alarms Set: Alarm 1ENT Assign to:  O2
ENT Outputs: OnENT ENT

(O2, Press)(Alarm 1, Alarm 2) (On, Off)

(Edit O2 (ppm))(lin(ppm), raw mV, log(ppm)) (Edit O2 (ppm))

Audible: On Visible: OnENT Polarity: ENT

(On, Off)(On, Off) (        )

1.000E+01 Contacts: N/OENT Contacts: N/O
Alarms set

1.250E+03=10V
Outputs set

ENT

2. Clean Sensor
(Zirconia sensor only)

Clean Sensor?ENTESC Cleaning SensorENT Cleaning Sensor
Sensor cleaned

Bargraph for 5s Displays for 1.5s

Calib: O2 Low 1.000E+01ppmENT 9.120E+00ppm O2ENT 1.000E+01ppm O2
O2 calibrated

Edit O2 LOW Enter for 2s to calibrate Displays for 1.5s

ENT

0.000E+00=0V 1.250E+03=10VENT ENT

(Edit high pressure value)(Edit low pressure value) (Displays for 1.5s)

ESC - Back to Menu List. No changes

Back to Measurements. Changes applied

ESC

ESC

4. Set Outputs O2 out: lin(ppm)ENT 1.000E+01=0VENT 2.500E+05=10VENT ENTESC

(bar, psi, mbar, kPa, torr)(Auto%, Pressure, N2 Bal %,
Exp ppm, Auto ppm)

(Displays for 1.5s)

5. Set Units Oxygen: Auto %ENT Pressure: barENT Pressure: psi
All units set

ENTESC

Back to Menu List. Changes applied

Continues on next page
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096E+05ppm   O2
0.0mbar

6. Display Setup Line 2 OptionsENT L2: PressureENT L2: Pressure
Line 2 set

ENT

Refresh interval Interval: 0.3sENT Interval: 0.3s
LCD refresh set

ENT

(Pressure, None) Displays for 1.5s

Displays for 1.5s

Displays for 1.5s

0.1 - 1.5s

8. Set Baud Rate Baud Rate: 57600ENT Baud Rate 57600
Baud Rate set

ENT

(9600, 57600)

7. Pressure Mode Mode: NoneENTESC ENT

Mode: Auto 1.000E+03mbarENT 1.013E+03mbar
Pressure set

ENT

Displays for 1.5s

Displays for 1.5s

Displays for 1.5s

Edit ambient pressure

ESC - Back to Menu List. No changes

ESC

ESC

9. Set Pump Flow
(A1 version only)

Pump flow: 90%ENT Pump flow: 100%
Pump flow set

ENT

Select pump speed

ESC

Displays for 1.5s

Edit password

Enable or Disable selected

10. Load Defaults Load Defaults?ENT Defaults LoadedENT

Enter for 2s to load defaults

Enter password, default 0000 Enable, Disable, Change

ESC

Back to Menu List. Changes applied

11. Password Password: 0***ENT Password: EnableENT

Password: 6234

Password: Enable
Password enabled

ENTESC

Continued from previous page

Mode: None
Mode configured

Figure 3 Menu Structure
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2.4 Display Possibilities

Sensor Reading Display Possibilities
O2 reading > 9999.9% Display shows O/Range

O2 reading > 1.0 ppm and < 9999.9% Display shows the normal oxygen reading 
in % or ppm

O2 reading > 0.5 ppm and < 1.0 ppm Display flashes to warn the measurement 
limit is approaching

O2 reading < 0.5 ppm Display shows U/Range

O2 reading is flashing
Indicates that the pressure sensor is out of 
range and automatic pressure correction is 
on

O2 sensor takes > 10 minutes to warm up Display shows Possible sensor Fault 
because the sensor heater is failing

O2 sensor has failed completely or become 
disconnected Display shows No sensor or sensor Fault

O2 sensor is ok but the pressure sensor 
is faulty and the auto pressure correction 
mode is selected

Display shows Fault flashing

Pressure Sensor Display Possibilities
Pressure reading is > 1000 mbar Display shows O/Range Press

Pressure reading is > -1000 mbar and 
< 1000 mbar

Display shows the normal pressure reading 
in mbar, bar, kPa, torr or psi

Pressure reading is < -1000 mbar Display shows U/Range Press

Pressure sensor has failed completely or 
become disconnected

Display shows Fault Press with the word 
Fault flashing

Other Sensor Display Possibilities

Reading >100% (on a 0-100% sensor 
only)

Display shows 100.0% until 102% is 
reached and then starts to flash.  Above 
104% shows O/Range 

Reading > the full scale value of the sensor 
fitted Display will show O/Range

Reading between 0% and the full scale 
value of the card fitted Display shows the normal reading

Reading < 0% 
Display shows 0.0% flashing and then 
displays U/Range. The values that trigger 
this depend on the type of card fitted.

Table 1 Sensor Reading Display Possibilities
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2.5 Set-Up

Ensure that the XGA301 analyzer is located away from extreme heat and dirty 
environments. Plug the unit into a suitable supply, using the power cable supplied, and 
into the power socket (Figure 2 (7)) on the rear panel. Make sure that the cooling fan 
(Figure 2 (8)) is not obstructed during operation. 

2.5.1 Precautions

Always make sure to use an in-line particle filter as the infrared and electrochemical 
sensors can be sensitive to contamination.  

The analyzer has been designed for use with non-condensing samples only. Sample gas 
must be dried before entering the analyzer to prevent condensation. In practice this 
means lowering the dew point of the gas to 10°C below the temperature of the sensor.

There are no user serviceable parts in this unit. Do not attempt repair yourself. Refer all 
servicing to qualified Michell Instruments personnel.

NOTE: If the background gas is flammable then the (optional) flame arrestor 
must be specified at the time of order.

2.5.2 Gas Connection

The unit is supplied as standard with push fit gas connectors located on the front or rear 
panel of the instrument, depending on configuration. Place the retaining collar over the 
sample tube (6mm OD/4mm ID) then push the tube onto the GAS IN (Figure 1 (2)) and 
GAS OUT (Figure 1 (3)) connectors and tighten the retaining collar by hand.

Alternatively the unit can be supplied with Quick connect (Rectus) or Swagelok 6mm 
connections.

!
Warning - when using Rectus fittings:

Always connect the outlet fitting before the inlet to avoid 
pressurizing and damaging the internal pipe work and/or 

sensor.

Turn the unit on using the red power switch on the front (Figure 1 (4)). The LCD (Figure 
1 (1)) will display the firmware version and may be followed by the message HEATING 

SENSOR (dependent on sensor fitted). 

Allow thirty minutes for the unit to stabilize fully. This allows the components of the 
analyzer to reach a stable working temperature. 

NOTE: When the XGA301 is supplied without a pump AND with an 
electrochemical sensor then there will be an additional gas outlet port on 
the rear panel (see figure 2). This port acts as a vent for the pressure relief 
valve to ensure the sensor is not damaged by over-pressure. This port must 
be vented to a safe place especially when toxic or flammable samples are 
present.  
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2.6 Flame Arrestor

The analyzer can be fitted with a flame arrestor that is compulsory when the target gas 
is flammable (CH4 and CO). 

NOTE: If the background gas is flammable then the flame arrestor must be 
specified at the time of order.  

2.7 LCD Display

The XGA301A1 and A2 are supplied with 2 line displays while the XGA301 A3 is supplied 
with a 4 line display. When a stable working temperature has been reached the LCD 
display will show the concentration of the gas(es) measured. In the event of an alarm 
condition, either AL1 or AL2 may appear. U/Range, O/Range, or CHANGE RANGE may 
appear when the sensor limits are reached, and FAULT will display if there is a problem 
with the sensor.

2.7.1 Setting the Display Units
The notation used by the display is fully programmable to suit your needs using the 
keypad (Figure 1 (5)) or the software provided (Appendix C). 

The following options are available:

1. Oxygen: The oxygen reading can be displayed in percent (e.g. 20.95%), 
ppm (e.g. 0.01 ppm) or scientific (e.g. 2.095E+05 ppm). If percent is 
selected the XGA301 will display oxygen as a percentage down to 0.1% 
and ppm below this value. There are also options to display the oxygen 
reading in terms of a pressure (units will be the same as the units selected 
for pressure) or a nitrogen balance (%N2) reading. In this case the reading 
displayed is 100-O2% = N2 so for example in air 21% the nitrogen balance 
reading will display 79% N2. NOTE: This is NOT an actual nitrogen 
reading.

2. Pressure: The reading can be displayed in mbar, bar, psi, torr or kPa.

3. Dew point: The reading can be displayed as °C, °F or ppm. 

4. Temperature: The reasing can be displayed as °C or °F

5. CO, CO2, CH4 sensors: These can be displayed in % or ppm.

To program these options scroll down to menu option Set Units and press the ENT key. 
Use the ENT key to progress through the list and the the UP & DOWN arrows to select 
the required units. Once selected press the ENT key to store and return to run mode.
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2.7.2 Setting the Display Options

The user can select the LCD refresh rate and format what Line 2 or Line 4 displays using 
the keypad or the software provided. Scroll down to menu option Display Setup and 
press the ENT key. Use the UP & DOWN arrows to select either the LCD refresh rate or 
Line 2 options:

Line 1: Line 1 displays the O2 concentration and the units can be chosen 
from %, ppm, mbar (or N2 balance for the A1 model only) and by using the 
UP & DOWN arrows to select the desired unit and pressing the ENT key 

to confi rm selection.

NOTE: If an XGA301A1 with a CO
2
 or CH

4
 sensor is specifi ed, this will be 

displayed on line 1 instead of O
2
.

Line 2 Options (XGA301A1): The information displayed on Line 2 can be 
chosen by the user. The options are None or Pressure (displayed in mbar, 
bar, psi, torr or KPa). 

Line 2 Options (XGA301A2): The information displayed on Line 2 of the 
LCD can be chosen by the user. The options are Second Parameter (% or 
ppm), Pressure (displayed in mbar, bar, psi, torr or KPa) or scrolling between 
the two. 

Line 2 Options (XGA301A3): displays the second paramater.

Line 3 Options (XGA301A3): displays the third parameter.

Line 4 Options (XGA301A3): This line can display Pressure, Temperature, 
Alternating (between pressure and temperature) or Date & Time.

LCD Refresh Interval: The frequency of the display update can be selected 
from 0.1 to 1.5 seconds. The current setting can be edited using the same 
method as described previously. Once edited press the ENT key to store and 
return to the main menu. The default setting is 0.3 seconds.

2.8 Pump Control (if fitted)

There is an optional internal sample pump, if fitted there will be a Pump On/Off switch 
(Figure 2 (9)) on the rear panel. 

A1 model: 
The flow rate of gas drawn into the analyzer can be controlled using menu option Set
Pump Flow. The unit is supplied with the flow rate set to 100% which equates to
approximately 1.2 l/min. If the flow rate needs to be changed press the ENT key and
use the UP & DOWN arrows to change the value from OFF to 100% in 10% increments.
The pump can be switched on or off using the switch (Figure 2 (9)) on the rear panel.
When using the unit with a pressurized gas source the pump can be switched off.

A2 & A3 Models:
The flow rate of gas drawn into the analyzer can be controlled with the metering valve 
on the front panel. The flow rate should be set at approximately 1l/min.
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NOTE: There will be no external pump switch when rear gas ports are fitted.

2.9 Menu Access / Passwords

The analyzer has an option to set a password that will restrict access to the menus. The 
password menu is disabled by default in the factory. To password protect the analyzer 
press the ENT key and scroll down to the menu option PASSWORD. Pressing the ENT 
key again will ask for the default password which is 0000. Enter this using the UP arrow 
and then the RIGHT arrow until 0000 appears on the screen, then press the ENT key. 
Once the password has been entered successfully. choose between ENABLE, CHANGE 
or DISABLE in the menu using the UP & DOWN arrows.

To CHANGE the password to a new value use the UP & DOWN arrows, pressing the 
RIGHT arrow after each digit to move to the next digit, and press the ENT key to 
accept. Press the ENT key at any stage to accept whatever is currently displayed as the 
password. The password must be 4 digits long and can be any combination of numbers 
from 0-9. Make sure that the new password is noted down.

If the password function ENABLE has been chosen, each time the menu system is 
accessed the password prompt will display. After the correct password is entered then 
the full menu will be accessible. Press the ESC key to leave the password protected area 
and return to the Main Screen. 

If the password has been forgotten contact Michell Instruments for advice on how to 
recover it.

2.10 Alarms

The XGA301 is fitted with two independent and fully programmable alarm relay outputs, 
which can be programmed to be either normally open (N/O - closes on alarm) or 
normally closed (N/C - opens on alarm). Each alarm has the option of being assigned 
to the oxygen, pressure (internal) or temperature sensors. It is also possible to enable 
the alarm relay circuits, enable an audible buzzer and enable a visual warning on the 
screen.

The alarms can be programmed by the user via the keypad (Figure 1 (5)) on the front 
panel or using the software provided (Appendix C). To change the alarm settings scroll 
down to the menu option Set Alarms and press the ENT key. Now use the UP & DOWN 
arrows to select Alarm 1 or Alarm 2 and press the ENT key. The next screen shows the 
message Assign To:. Use the UP & DOWN arrows to select O2 or Pressure depending 
on which measurement is needed, and press the ENT key to proceed. The default is O2. 

The next settings configure the behaviour of the alarm. Use the UP & DOWN arrows to 
select ON or OFF for the following parameters:

1. OUTPUTS: This enables the rear panel relay outputs when ON is selected.

2. AUDIBLE: This enables or disables the audible buzzer inside the unit 
which will sound in an alarm condition.
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3. VISIBLE: This enables or disables warning messages on the LCD screen 
on the front of the XGA301. During an alarm condition either AL1 or AL2 
(or a combination of both) will flash at the bottom right hand corner of 
the display.

4. POLARITY: This determines whether a rising or falling alarm is being 
set. Use the UP & DOWN arrows to change the direction of the alarm to 
up or down. A rising alarm means that the alarm will be silent at values 
below the set-point but as soon as the value rises above the set-point the 
alarm will be triggered

5. SETPOINT: The current alarm set-point is displayed in scientific notation 
with a flashing cursor under the first digit. Use the UP & DOWN arrows to 
change the digit and the RIGHT arrow to progress until the correct value 
is displayed. Press the ENT key to proceed to the next setting.

6. CONTACTS: The relay outputs can be set to either normally open (N/O) 
or normally closed (N/C). The factory default is N/O, meaning the contacts 
will close when an alarm condition occurs. Press the ENT key to save all 
the above settings for the selected alarm.

Alarm 2 can be set in exactly the same way as described above and both alarm circuits 
are completely independent of each other. NOTE: All the parameters must be 
programmed for each alarm in order for the settings to be saved. The bottom 
line of the LCD will display Alarm x set (where x is the selected alarm channel) to 
confirm that the settings have been saved.

The alarm circuit relays are accessed via the terminal block on the rear panel and are 
clearly labelled. Alarm 1 is assigned to the terminals labelled Alarm High and Alarm 2 is 
assigned to the terminals labelled Alarm Low. The relay circuit is rated at 24 V, 0.5 amps 
maximum.

Under certain conditions (e.g. the sensor becomes disconnected) the XGA301 will set 
the alarm channel to OFF to prevent false alarms, and the relay contacts for the affected 
channel will go to the programmed N/O or N/C setting. For more information refer to 
Table 2.

2.10.1 Auxiliary Alarms

The auxiliary outputs can be set to Pressure or any other sensor fitted. 

To select and modify the auxiliary alarm scroll down to menu option Set Outputs and 
press ENT four times. Use the up and down arrow buttons to choose between Pressure 
or other sensor and press ENT. If Pressure is selected then the permissible range is 
-1000mbarg to +2000mbarg.

During initial warm up of the XGA301 when the display reads the serial number the 
output sent to the rear terminal for oxygen will stay at 2mA (1 V) which is the standby 
signal.  Additional current and voltage signals are provided by the analyzer to give an 
indication of various conditions and these are described in Appendix D.2, together with 
the status of the alarms during the condition.
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2.11 Analog Outputs

The XGA301 analyzer provides various analog outputs. The standard industrial analog 
outputs (0 to 5/10 V and 4-20 mA) for both oxygen, and temperature (or internal 
pressure) are accessible via the terminal block (Figure 2 (6)) on the rear panel. These 
outputs have a 12 bit resolution (approximately 1 in 4000) and the lower and upper 
values are fully user-programmable using the keypad (Figure 1 (5)) or the software 
provided (Appendix C). In the case of oxygen, three output mode options are provided 
for setting the outputs in order to give the user maximum flexibility:

1. LIN: The linear output mode setting produces an output that is scaled 
linearly between 0 and 10 V (or 4 and 20 mA). So, for example, if the 
scale is set 0 V = 0% O2 and 10 V = 100% O2 then 5 V would indicate an 
oxygen reading of 50% O2. The scaling of this example is shown in the 
following plot, from which other intermediate values can also be read. 

Linear output mode
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Figure 4 Graph Showing Linear Output Mode Option For Oxygen

The following general formulae can be used to calculate the oxygen from the voltage or 
current outputs when set to the linear output mode:

Output type Formula for calculating oxygen from 
analog output signal

0-10 V O2 = Vout / 10 * (O2H - O2L) + O2L

4-20 mA O2 = (mAout – 4) / 16 * (O2H - O2L) + O2L

Where:  O2L = user setting of oxygen for 0 V or 4 mA output 1

   O2H = user setting of oxygen for 10 V or 20 mA output 1

   Vout = the measured voltage output in volts
   mAout = the measured current output in mA

   1   O2, O2L and O2H must all be in the same units.
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2. Zirconia sensor only - LOG (ppm): This setting produces an output 
that is scaled logarithmically between 0 V and 10 V (or 4 and 20 mA). 
So, for example, if the scale is set to 0 V = 0.0001% (1 ppm) and 10 V 
= 100% (1000000 ppm) then 5 V would indicate an oxygen reading of 
0.1% (1000 ppm). This scale is more suitable for large ranges of oxygen 
down to very low ppm levels. Note that because the scaling is logarithmic 
0 V cannot be set to 0% oxygen since log(0) is -∞. The lowest permitted 
setting is 0 V = 10-20 ppm (or 10-24%)O2. The scaling of this example 
is shown in the blue line in following plot, from which other intermediate 
values can also be read. For comparison the red line shows the limitations 
of using the linear oxygen output mode over the same range. This setting 
is more suitable for large ranges of oxygen e.g. 10 ppm to 21%.

"Log(ppm)": Log output mode

0

1.25

2.5

3.75

5

6.25

7.5

8.75

10

0.0001 0.001 0.01 0.1 1 10 100

O2 (%)

O
2 V

ol
ts

 o
ut

pu
t

4

6

8

10

12

14

16

18

20
-4 -3 -2 -1 0 1 2

log(O2 (%))

O
2 m

A 
ou

tp
ut

 
Figure 5 Graph Showing Logarithmic Output Mode

The following general formulae can be used to calculate the oxygen from the voltage or 
current outputs when set to the log output mode:

Output type Formula for calculating log10(O2) from 
analog output signal

0-10 V log10(O2) = Vout / 10 * log10(O2H / O2L) + log10(O2L)

4-20 mA log10(O2) = (mAout – 4) / 16 * log10(O2H / O2L) + 
log10(O2L)

Where:  O2L = user setting of oxygen for 0 V or 4 mA output 2

   O2H = user setting of oxygen for 10 V or 20 mA output 2

   Vout = the measured voltage output in volts
   mAout = the measured current output in mA

   2  O2, O2L and O2H must all be in the same units.

   NOTE: O2 = 10 log(O2)
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3. Zirconia sensor only - RAW (mV): This setting is for customers who 
like to monitor the raw sensor EMF signal. The signal from a sensor goes 
from approximately -50 mV at 100% O2 through zero at approx 5% O2 
and to +1000 mV at extremely low O2 levels. So, for example, if the scale 
is set to 0 V (output) = -50 mV (sensor voltage at approximately 100% 
O2) and 10 V (output) = 250 mV (sensor voltage at approximately 1 ppm 
O2) then 5 V would indicate a sensor voltage of 100 mV. The scaling of 
this example is shown in the following plot, from which other intermediate 
values can also be read.
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Figure 6 Graph Showing Raw Sensor mV Output Mode Option For Oxygen

The following general formulae can be used to calculate the oxygen sensor raw voltage 
(O2 mV) from the voltage or current outputs when set to the raw sensor voltage output 
mode:

Output type Formula for calculating sensor mV from 
analog output signal

0-10 V O2mV = Vout / 10 * (O2mVH - O2mVL) + O2mVL

4-20 mA O2mV = (mAout – 4) / 16 * (O2mVH - O2mVL) + O2mVL

Where:  O2mVL = user setting of oxygen mV for 0 V or 4 mA output 
   O2mVH = user setting of oxygen mV for 10 V or 20 mA output 
   Vout = the measured voltage output in volts
   mAout = the measured current output in mA

   The auxiliary outputs are fixed to the pressure sensor on this model. 

To modify the oxygen analog output range scroll down the menu option Set Outputs 
and press the ENT key. Use the UP & DOWN arrows to select the output type either 
lin(ppm), log(ppm) or raw(mV) and press the ENT key. The lower and upper values can 
now be edited using the the UP, DOWN and RIGHT arrows. Once programmed the new 
values remain in the memory until they are edited again in the future.
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2.12 Pressure Outputs

To select and modify the pressure outputs scroll down to menu option Set Outputs and 
press the ENT key four times. Change the low and high range using the same procedure 
described above. The permissible range is -1000 mbarg to +2000 mbarg.

NOTE: The voltage (0 to 5/10 V) and current (4 to 20 mA) outputs are locked 
together, so that these outputs cannot be set independently of each other. In 
normal operation therefore, 0 V output always corresponds to 4 mA and 5/10 V 
always corresponds to 20 mA output.

During initial warm up the XGA301 will display the serial number and the output sent 
to the rear terminal for oxygen will stay at 2 mA (1.25 V) which is the standby signal. 
If at any stage a sensor becomes disconnected internally, or the signal exceeds the 
measurable range for that sensor, then the display will indicate there is a fault and the 
outputs will change to 1 mA (0.625 V) which is the sensor fault signal. This will recover 
as soon as the sensor is reconnected and the fault cleared. Additional current and 
voltage signals are provided by the analyzer to give an indication of various conditions 
and these are described in Appendix D, together with the status of the alarms during 
the condition:

2.13 Pressure Mode

The user has the option of using the reading from the internal pressure sensor (where 
fitted) to automatically correct for changes in gas pressure and hence oxygen pressure. 
A manual pressure correction value for ambient pressure conditions can also be entered 
to improve accuracy of the correction (factory setting is 1013 mbar absolute). To access 
this function scroll down to menu option Pressure Mode and press the ENT key. The 
desired mode can then be selected using the UP & DOWN arrows and pressing the ENT 
key to store and proceed. The two modes available are:

1. None: If this mode is selected then there is no pressure correction 
performed on the oxygen reading. The pressure and oxygen sensor act 
independently. If the sensor is working in air (20.95%) and the pressure 
is doubled to 1000 mbarg then the reading will also double to 41.9%. 
This is the correct oxygen partial pressure in air at 1 barg since there is a 
simple linear relationship between pressure and concentration.

2. Auto: This is the factory default setting. If the Auto mode is selected then 
the XGA301 uses the reading from the internal pressure sensor to correct 
the oxygen partial pressure and maintain a concentration reading. If the 
sensor is working in air (20.95%) and the pressure suddenly jumped 
to, for example, 500 mbar above atmospheric, the oxygen reading 
would remain at 20.95% because the sensor has been corrected for the 
pressure change. This allows users who are working with fluctuating input 
pressures to maintain a ‘meaningful’ reading of oxygen concentration that 
will only be affected by changes in gas composition and not gas pressure.

NOTE: When this mode is activated the user will be asked to enter a value for 
the current ambient pressure to slightly improve the accuracy of the correction. 
The factory default is 1013 mbara which is the standard atmospheric pressure 
at sea level. The ambient pressure at the location will depend on altitude and 
prevailing weather conditions. 

The user also has the option of selecting a flying lead pressure sensor. This would be 
replace the internal pressure sensor. the range would be 0-5 bar or 0-10 bar gauge 
standard, supplied on a 2m cable.
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2.14 Temperature Outputs

The type K thermocouple (if supplied) is connected via the socket on the rear panel 
(number 12 in figure 2). When fitted correctly the LCD will show the temperature in 
°C, °F or NONE. If this is not the case you will need to select the display option in the 
meny system. Press ENT and scroll down to no.7 "Display Setup". Press ENT to access 
and use the arrow keys to slect "Line 2 Options". Select "Temperature" (or "Alternate 
T/A" to alternate between temperature and the other sensor readings) and press ENT 
to confirm.

The thermocouple is an independent measurement from the oxygen sensor and it is not 
necessary to have it connected for oxygen measurements. The thermocouple can be 
positioned anywhere the user wishes, though typically it is placed in close proximity to 
the oxygen sensor so the measurement gas temperature can be recorded. The type K 
thermocouple measurement displays 0 to 125.0°C and is accurate to ±1%

2.15 Setting the Baud Rate

If using the software for data logging the communications speed can be chosen(Baud 
Rate) by scrolling down to menu option Set Baud Rate and using the UP & DOWN 
arrows to select either 9600 or 57,600. Press the ENT key again to store and return 
to normal operation. The default factory setting is 57,600. However if an older PC is 
being used, decrease this to 9600 to improve the reliability of the software and data 
communications.

2.16 RS232 Port

It is possible to factory-set the data communications port to RS232. Once configured at 
the factory it is not possible to change unless the unit is returned to Michell Instruments. 
Data from the XGA301 is sent on demand to the 9-way 'D' type socket (Figure 2 (10)) 
on the rear panel and can be read using a simple terminal program such as 'PComm 
Lite' (www.moxa.com/product/download_pcommlite_info.htm), or with the user's own 
custom software. Alternatively a simple and convenient data logger programme is 
included with the supplied software and is described in Appendix C.
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2.16.1 RS232 Protocol

Oxygen data can be read from the RS232 port at the back of the XGA301. The default 
RS232 configuration is 57600-8-N-1, as shown in this example for COM1:

 

Figure 7 XGA301 Default COM Properties Box

Alternatively, the baud rate can be reduced to 9600 via the menu option Set Baud Rate, 
using the front panel keypad on the XGA301. This setting is stored in EEPROM.

Connection: Connect to RS232 socket at the back of the XGA301 using a 9 way D-type 
plug. Signals are as follows:

XGA301 D-type Socket:  PC/PLC:
Pin# 2 = Data Out  Data In (RX)
Pin# 3 = Data In  Data Out (TX)
Pin# 5 = Common/Gnd -- Common/Gnd

5 4 3 2 1

9 8 7 6

RS232

 
Figure 8 XGA301 RS232 Pin Configuration

All other pins (1,4,6,7,8,9) = Not Used

Reading Data: Data is read using command “D”. Send the single character “D” to the 
XGA301. The XGA301 replies with one of the following responses. All valid responses 
end with [CR] & [LF] (where [CR] = ASCII 13 and [LF] = ASCII 10). 
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Response: !Initialising[CR][LF]
Meaning: XGA301 is still initialising

Response: !Sensor heating[CR][LF]
Meaning: XGA301 is still heating sensor to operating temperature

Response: !Sensor cooling[CR][LF]
Meaning: XGA301 is still cooling sensor to operating temperature. This can happen 

when switching from Normal to Helium operating mode.

Response: !Cleaning sensor[CR][LF]
Meaning: XGA301 has fi nished heating sensor and is cleaning the sensor for 5 seconds

Response: !User setup active[CR][LF]
Meaning: The confi guration menu has been activated via the front panel keypad. The 

menu will automatically time out 60 seconds after the last key was pressed, 
or press the ESC key to return immediately to normal run mode.

Response: !Possible sensor fault[CR][LF]
Meaning: The sensor has failed to reach operating temperature within 10 minutes from 

power up. This may be due to the age of the sensor, or because a high 
thermal conductivity gas is being used.

Response: !No sensor or sensor fault[CR][LF]
Meaning: Sensor is not connected, or there is a fault in the sensor

Response: d2.959E+05,-1.426E+01,2.000E+00,,23:19:40,14/01/00,,,ALM1&2,0[CR][LF]
Meaning: “d” means data is being sent 
   “2.959E+05” is Oxygen reading in ppm
   “,” = data separator
   “-1.426E+01” is Oxygen sensor reading in mV
   “,” = data separator
   “2.000E+00” is the internal pressure sensor reading in bar (gauge)
   “,” = data separator
   “23:19:40” is XGA301 time 
   “,” = data separator
   “14/01/00” is XGA301 date in DD/MM/YY format 
   “,,,” = data separators
   “ALM1&2” means both alarm conditions 1 and 2 exist *
   “,” = data separator
   “0” = sensor state code (0=OK, 1=O2 O/Range, 2= O2 U/Range, 
   3=O2 Fault, 4=Press. U/Range, 5=Press. O/Range, 6= Press. Fault**)
   [CR] = ASCII 13 (Carriage Return character)
   [LF] = ASCII 10 (Line Feed character)
 

*  If no alarm conditions exist, this data is empty, so the response would look 
like d2.959E+05,-1.426E+01,2.000E+00, ,23:19:40,14/01/00,,,,0[CR][LF]

** These are binary codes so fault combinations produce other numbers

Response: ?
Meaning: “D” command was not recognized. Try to send it again.
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2.17 Printing

The printer option allows print out various data from the analyzer straight on to thermal 
paper. Simply connect the printer to the unit using the serial socket on the rear of the 
machine and make sure the printer is switched on (battery and mains versions are 
available). To print the live values on the LCD at any time simply press the RIGHT arrow 
on the front panel. Each push of the button will print out the serial number followed 
by the data in a tabbed format followed by a blank line. If the button is held down, the 
printer will keep printing data (but not the serial number).

When the printer is first connected or turned on, a start-up message like the one 
displayed on the LCD when the XGA301 is switched on will be printed, and will look like 
this:

Michell Instruments
XGA301
Oxygen Analyzer
S/N: 146877
FW v 01.01.12.21
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3 ZIRCONIA SENSOR

3.1 Start-Up

The sensor will take approximately four minutes to come up to temperature, after which 
the XGA301 will begin to take measurements. The progress of the sensor heater is 
shown in the form of a bar graph on the LCD (Figure 1 (1)).

During the warm-up period it is common for the baseline oxygen to drift by a small 
amount, which may be corrected by re-calibrating (see Section 3.1).

!

The unit is not suitable for enriched oxygen samples 
(O2 > 21%).

While the sensor is capable of measuring oxygen up to 30%, it 
is NOT recommended as the sample wetted materials are not 

suitable for enriched oxygen.

3.2 Cleaning the Zirconia Sensor

The sensor head is located inside the analyzer and comprises a zirconia ceramic tube that 
needs to be heated to 650°C before it will conduct oxygen ions. The analyzer supplies 
heat to the sensor, which is controlled very accurately by a regulated power supply 
incorporated in the instrument. An internally mounted pressure sensor compensates for 
any fluctuations in pressure or vacuum caused by differing flow conditions. 

The sensor can be cleaned at any time by pressing the ENT key on the keypad (Figure 
1 (5)) and scrolling down to menu option Clean Sensor or using the software described 
in Appendix C. Press the ENT key to proceed. The screen displays Clean Sensor?. Press 
the ENT key again and the cleaning will take place. The procedure takes approximately 
five seconds and the LCD display shows the progress of the operation. Once finished the 
analyzer will take a moment to re-stabilize. The sensor is cleaned each time the unit is 
switched on prior to operation. If operating in gases with large amounts of soot, there 
is a risk that the sensor surfaces will become contaminated with particulates, which 
will impair performance if allowed to build up. The cleaning operation pumps oxygen 
through the zirconia tube, which burns the particulates away from the sensor surface.

3.3 Load Defaults

If a mistake is made while programming the XGA301 it is possible to restore the machine 
back to its factory settings by loading the unique default configuration that is supplied 
on the software CD-ROM. The default set-up can only be accessed using the software 
provided. See Appendix C for further details.

Alternatively, reset to generic factory defaults directly from the front panel keypad. 
Press the ENT key to enter the user setup menu and select menu option Load Defaults 
and press the ENT key to proceed. The next screen will say Load Defaults ? with the 
prompt to press and hold the ENT key for 2 seconds to confirm. To complete this - press 
the ENT key until the bar graph has completed and the screen says Defaults Loaded. 
This will give all the basic settings that are factory set. Re-calibrate the sensor and 
check all the settings are suitable.
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3.4 Calibration of Zirconia Sensor

Full calibration is a simple procedure requiring two or three gases (one of which is 
normally air – 20.95%). The two gas values are user-selectable and can be changed by 
using the front keypad (Figure 1 (5)) or the Communications Software as described in 
Appendix C. The calibration values can be stored on file for later use.

Care must be taken to calibrate the analyzer so that, whenever possible, the range of 
measurement lies between the two calibration point extremes. For example, if working 
at 10 ppm but have calibrated the analyzer between 21% and 100% then the analyzer 
will be inaccurate. It should be calibrated at about 4 ppm and 21% to be sure of good 
accuracy. The procedure is as follows:

1. Decide which two (or three) gases are going to be used for calibration. 
Press the ENT key on the front panel keypad (Figure 1 (5)) to access the 
menu system. The calibration function is on the menu list, which can be 
scrolled using the UP & DOWN arrows. Press the ENT key again to enter 
the calibration menu. Use the UP & DOWN arrows to select O2 HIGH, 
O2 MIDDLE or O2 LOW and press the ENT key to proceed. The top line 
of the display shows the current calibration gas stored and the bottom 
line of the display shows the prompts. If the gas value is not what is 
required, edit the value (in ppm scientific notation) using the UP, DOWN 
and RIGHT arrows on the keypad. The cursor flashes underneath the digit 
to edit. For example air (20.95%) should be entered as 2.095E+05 ppm 
(209,500 ppm). NOTE: It is not possible to go backwards to edit a 
digit to the left of the cursor. Instead keep pressing the RIGHT arrow 
and the cursor will wrap around back to the beginning. Alternatively press 
the ESC key to start again. Press the ENT key when ready to proceed.

Scientific Format Meaning Equivalent Equivalent
ppm Percent

1.000E+06 ppm 1.000 x 1,000,000 1,000,000 ppm 100.00%
2.095E+05 ppm 2.095 x 100,000 209,500 ppm 20.95%
1.000E+05 ppm 1.000 x 100,000 100,000 ppm 10.00%
1.000E+04 ppm 1.000 x 10,000 10,000 ppm 1.000%
1.000E+03 ppm 1.000 x 1,000 1,000 ppm 0.100%
1.000E+02 ppm 1.000 x 100 100.0 ppm 0.010%
1.000E+01 ppm 1.000 x 10 10.00 ppm 0.001%
1.000E+00 ppm 1.000 x 1 1.000 ppm 0.0001%

Table 2 Common Scientific Format
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2. The sensor needs to be exposed to the first calibration gas from a cylinder 
(or exposed to ambient air, 20.95% if this is the calibration gas of choice). 
Allow several minutes to pass to flush the sensor properly. Wait for the 
top line of the display (Figure 1 (1)) to become stable. To complete the 
calibration, press and hold the ENT key for two seconds. During this time 
a bar graph will progress across the lower display. The analyzer will then 
recalibrate and display O2 recalibrated and then return to normal run 
mode. The display will now correctly read the value of the first calibration 
gas. NOTE: If the ENT key is released before two seconds have 
elapsed, the recalibration will be aborted and when the analyzer 
eventually returns to run mode it will use the existing calibration.

3. The analyzer should ideally be calibrated at normal ambient pressure. 
If the pressure correction mode is set to AUTO then it is still possible to 
perform an accurate calibration at pressures other than ambient. However 
above 25 mbar (gauge) or below -25 mbar (gauge) the display will flash 
and P? will display to warn that the pressure is either above or below the 
range recommended for accurate calibration.

4. The analyzer predicts the correct signal from the sensor during calibration 
and if this is outside the range of expected values then the display will 
flash and display G? to warn that either the cal gas flowing over the 
sensor is different to the value that has been programmed OR the sensor 
may be old and approaching the end of its life. Check before proceeding!

5. Repeat this procedure with the second and third calibration gases.

6. If at any time, difficulties are encountered and the machine needs to 
be restored to its factory set calibration, use the configuration software 
provided and load the default settings. Each machine is provided with a 
unique file that contains the factory settings. This is located on the CD-
ROM provided and is copied onto a PC during the installation process.

7. The three calibration points are independent of each other so the analyzer 
can be calibrated in any order. However note that O2 HIGH must always 
be greater than O2 MIDDLE which must always be greater than O2 LOW. 
Typically the factory settings are: O2 HIGH=20.95%, O2 MIDDLE=0.1% 
(1000 ppm) and O2 LOW=0.001% (10 ppm).

NOTE: A FULL calibration must be performed to achieve good accuracy. 
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4 DEW-POINT SENSOR

The sensor is provided with a 7 point factory calibration certificate. Michell Instruments 
recommends that the sensor is either returned for factory calibration, or exchanged for 
a newly calibrated unit.  Please note, a sensor exchange program is in place, details of 
which can be provided by your local Michell office or representative.

To measure water dew point correctly use appropriate fittings, tubing and regulators.
Only use FEP or stainless pipe when measuring dew point as most plastics are highly
permeable to water molecules. If running pipes from a gas regulator make sure good
quality Swagelok type fittings are used and any gas regulators are fitted with stainless
steel diaphragms. See section 7 for more detailed advice on sampling.

An XGA301 fitted with Rectus connectors will hold a dry sample inside the analyser when 
disconnected, reducing the dry down times required before the next measurement. 

!
Warning:

Always connect the outlet fitting before the inlet to avoid 
pressurizing and damaging the internal pipe work.

H2O Reading: The default setting for Line 2 of the display is H2O. Other options for 
line 2 are Pressure (displayed in mbar, bar, psi, torr or kPa), or to alternate between 
pressure and H2O (both H2O and pressure are displayed alternatively) or the date and 
time (displayed dd/mm/yy HH:mm:ss). Use the UP & DOWN arrows to select the display 
required and press ENT to store and return to normal operating mode. 

If either the dew-point or pressure sensor fails in any way they will report “Fault H2O” 
or “Fault Press” on the second line of the display. If pressure correction is set to “Auto” 
and there is a fault with the pressure sensor then the oxygen reading will also display 
“Fault” to warn that it may be unreliable. Please contact Michell Instruments for advice.

When configuring the software please refer to Appendix C.6.1. Auxiliary Analog 
Output (0 V/4 mA & 10 V/20 mA).

H2O Calibration Gas 1 & 2 are greyed out when an Easidew is fitted as the sensor 
must be returned to Michell Instruments for calibration.

H2O Sensor ADC Reading High & Low: These boxes are for diagnostic purposes only 
and show the ADC value that the H2O sensor is transmitting at 4 mA and 20 mA.

Alarm Source: Use the drop down box to assign a detector to the alarm. If the alarm 
is to be based on dew-point readings select H2O from the drop down list. 
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Real Time Graph

When selected, the Easidew output will be displayed on a graph with the other 
measurand. It is possible to have dual scaling on the Y axis.

The example below has oxygen and dew point:

 

Configuring the Second Y Axis

The secondary Y axis located on the right hand side of the graph can be used to display 
either H2O or pressure taken from the internal pressure sensor. It is not possible to 
display H2O and pressure at the same time. The axis is linear and auto-scaling. To select 
the mode of the secondary axis select ‘View’ and then ‘Second Axis Display’. Choose 
from the available list.
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5 ELECTROCHEMICAL SENSOR

The XGA301 can be supplied with O2 or CO electrochemical sensors which are range 
specific. Electrochemical sensors are consumable items and can be considered to 
operate like a battery. The greater the concentration of the target gas exposed to the 
sensor the quicker it will be consumed. It is important to select the correct sensor type 
for your application to maximize sensor life. Typically the sensor should be chosen to 
suit the maximum concentration the unit is likely to measure. 

For example: If the process ranges between 800 to 1000 ppm CO then a sensor ranged 
0 to 2000 ppm will last longer than one ranged 0 to 1000 ppm. 

The XGA301 is supplied with two types of electrochemical oxygen sensor.  One for low 
range readings only and is specified as 0-1% O2 (primarily designed to measure sub 
100ppm O2), this has one operating range and must not be exposed to air for more 
than a couple of minutes to avoid rapid consumption of the sensor. 

The other sensor is suitable for measuring up to 30% oxygen and has three selectable 
measurement ranges which can be configured by the user.  Always select the most 
appropriate range in order to achieve maximum resolution from the analyser. 

The three ranges are labelled HIGH, MEDIUM & LOW.
1. High from 0.1% to 30% oxygen
2. Medium from 100ppm to 30% oxygen
3. Low from 10-20ppm to 30% oxygen

The range currently in use is denoted by the character (L), (M) or (H). To change the 
range select  “Set O2 Range” and press ENT. Use the UP & DOWN arrows to select the 
required range and press ENT to finish. If the measurement is out of range then the 
display will flash with the message “Change Range” to warn you to change over to a 
lower range to continue reading.

!
Low range oxygen sensors will be consumed very quickly if 

exposed to air. Flush the analyzer with nitrogen (or any oxygen 
free gas) and switch off when not in use. There is a "normally 

closed" electro-valve that isolates the sensor when the power is 
switched off. This prolongs the life of the sensor.

5.1 Electrochemical Sensors and Pressure

Electrochemical sensors cannot be exposed to pressures greater than 0.5 barg (7.25 
psig). The sensor can be damaged resulting in the electrolyte being flushed out of 
the sensor causing damage to the analyzer and any pipework downstream. A similar 
situation can occur if the sensor is exposed to a vacuum. 

NOTE: When the XGA301 is supplied without a pump AND with an 
electrochemical sensor then there will be an additional gas outlet port on the 
rear panel. This port acts as a vent for the pressure relief valve to ensure the 
sensor is not damaged by over-pressure. This port must be vented to a safe 
place especially when toxic or flammable samples are present.  

NOTE: The CO sensor must not be used with a H2 background
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5.2 Calibration of Electrochemical Sensor

Calibration is a simple procedure requiring two gases, one for Zero and one for Span 
- note that we will be using O2 for all examples in this section. The two gas values are 
user-selectable and can be changed by using the front keypad (Figure 1 (5)) or the 
Communications Software as described in Appendix C. The calibration values can be 
stored on file for later use.

The Span gas must be between 80 and 100% of the instrument range. Care must be 
taken to calibrate the analyzer so that, whenever possible, the range of measurement 
lies between the two calibration point extremes. For example, if working between 900 
and 1000 ppm O2, then using a Span gas of 800 ppm would be unsuitable as the 
working range would be outside of the calibrated range of the instrument. 

The procedure is as follows:

1. Press the ENT key on the front panel keypad (Figure 1 (5)) to access the 
menu system. The calibration function is on the menu list, which can be 
scrolled using the UP & DOWN arrows. Press the ENT key again to enter 
the calibration menu. Use the UP & DOWN arrows to select O2 HIGH or 
O2 LOW and press the ENT key to proceed. The top line of the display 
shows the current calibration gas stored and the bottom line of the display 
shows the prompts. If the gas value is not what is required, edit the value 
(in ppm scientific notation) using the UP, DOWN and RIGHT arrows on 
the keypad. The cursor flashes underneath the digit to edit. For example 
air (10%) should be entered as 1.000E+05 ppm (100,000 ppm). NOTE: 
It is not possible to go backwards to edit a digit to the left of the 
cursor. Instead keep pressing the RIGHT arrow and the cursor will wrap 
around back to the beginning. Alternatively press the ESC key to start 
again. Press the ENT key when ready to proceed.

Scientific Format Meaning Equivalent Equivalent
ppm Percent

1.000E+06 ppm 1.000 x 1,000,000 1,000,000 ppm 100.00%
2.095E+05 ppm 2.095 x 100,000 209,500 ppm 20.95%
1.000E+05 ppm 1.000 x 100,000 100,000 ppm 10.00%
1.000E+04 ppm 1.000 x 10,000 10,000 ppm 1.000%
1.000E+03 ppm 1.000 x 1,000 1,000 ppm 0.100%
1.000E+02 ppm 1.000 x 100 100.0 ppm 0.010%
1.000E+01 ppm 1.000 x 10 10.00 ppm 0.001%
1.000E+00 ppm 1.000 x 1 1.000 ppm 0.0001%

Table 3 Common Scientific Format
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2. The sensor needs to be exposed to the first calibration gas from a cylinder. 
Allow several minutes to pass to flush the sensor properly. Wait for the 
top line of the display (Figure 1 (1)) to become stable. To complete the 
calibration, press and hold the ENT key for two seconds. During this time 
a bar graph will progress across the lower display. The analyzer will then 
recalibrate and display O2 recalibrated and then return to normal run 
mode. The display will now correctly read the value of the first calibration 
gas. NOTE: If the ENT key is released before two seconds have 
elapsed, the recalibration will be aborted and when the analyzer 
eventually returns to run mode it will use the existing calibration.

3. The analyzer should ideally be calibrated at normal ambient pressure. 
If the pressure correction mode is set to AUTO then it is still possible to 
perform an accurate calibration at pressures other than ambient. However 
above 25 mbar (gauge) or below -25 mbar (gauge) the display will flash 
and P? will display to warn that the pressure is either above or below the 
range recommended for accurate calibration.

4. The analyzer predicts the correct signal from the sensor during calibration 
and if this is outside the range of expected values then the display will 
flash and display G? to warn that either the cal gas flowing over the 
sensor is different to the value that has been programmed OR the sensor 
may be old and approaching the end of its life. Check before proceeding!

5. Repeat this procedure with the second calibration gas.

6. If at any time, difficulties are encountered and the machine needs to 
be restored to its factory set calibration, use the configuration software 
provided and load the default settings. Each machine is provided with a 
unique file that contains the factory settings. This is located on the CD-
ROM provided and is copied onto a PC during the installation process.

NOTE: A FULL calibration must be performed to achieve good accuracy. 

5.2.1 Low Range Electrochemical Sensor

If the sensor is being calibrated for the first time it makes sense to perform the Span 
calibration first as it could take an hour or so to reach close to 0 ppm. 

However, during normal operation it makes sense to calibrate the low point first, then the 
Span, as electrochemical sensors are relatively quick to measure from low concentration 
to high concentration. 
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6 INFRARED SENSOR

The XGA301 can be supplied with CH4, CO or CO2 infrared sensors which are range 
specific. Infrared sensors are not considered consumable items and should, in normal 
use, last the life of the analyzer. 

It is recommended to select a sensor where the target concentration is in the middle of 
the calibrated range. 

6.1 Flammable Samples

The analyzer can be fitted with a flame arrestor that is compulsory when the target gas 
is flammable (CH4 and CO). 

NOTE: If the background gas is flammable then the flame arrestor should be 
specified at the time of order.  
 

6.2 Calibration of Infrared Sensor

Full calibration is a simple procedure requiring two gases, one for Zero and one for Span 
- note that we will be using CO2 for all examples in this section. The two gas values 
are user-selectable and can be changed by using the front keypad (Figure 1 (5)) or the 
Communications Software as described in Appendix C. The calibration values can be 
stored on file for later use.

The Span gas must be between 80 and 100% of the instrument range. Care must be 
taken to calibrate the analyzer so that, whenever possible, the range of measurement 
lies between the two calibration point extremes. For example, if working between 90 
and 100% CO2, then using a Span gas of 80% would be unsuitable as the working range 
would be outside of the calibrated range of the instrument. 

The procedure is as follows:

1. Press the ENT key on the front panel keypad (Figure 1 (5)) to access the 
menu system. The calibration function is on the menu list, which can be 
scrolled using the UP & DOWN arrows. Press the ENT key again to enter 
the calibration menu. Use the UP & DOWN arrows to select CO2 HIGH or 
CO2 LOW and press the ENT key to proceed. The top line of the display 
shows the current calibration gas stored and the bottom line of the display 
shows the prompts. If the gas value is not what is required, edit the value 
(in ppm scientific notation) using the UP, DOWN and RIGHT arrows on 
the keypad. The cursor flashes underneath the digit to edit. For example 
air (10%) should be entered as 1.000E+05 ppm (100,000 ppm). NOTE: 
It is not possible to go backwards to edit a digit to the left of the 
cursor. Instead keep pressing the RIGHT arrow and the cursor will wrap 
around back to the beginning. Alternatively press the ESC key to start 
again. Press the ENT key when ready to proceed.
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Scientific Format Meaning Equivalent Equivalent
ppm Percent

1.000E+06 ppm 1.000 x 1,000,000 1,000,000 ppm 100.00%
2.095E+05 ppm 2.095 x 100,000 209,500 ppm 20.95%
1.000E+05 ppm 1.000 x 100,000 100,000 ppm 10.00%
1.000E+04 ppm 1.000 x 10,000 10,000 ppm 1.000%
1.000E+03 ppm 1.000 x 1,000 1,000 ppm 0.100%
1.000E+02 ppm 1.000 x 100 100.0 ppm 0.010%
1.000E+01 ppm 1.000 x 10 10.00 ppm 0.001%
1.000E+00 ppm 1.000 x 1 1.000 ppm 0.0001%

Table 4 Common Scientific Format

2. The sensor needs to be exposed to the first calibration gas from a cylinder. 
Allow several minutes to pass to flush the sensor properly. Wait for the 
top line of the display (Figure 1 (1)) to become stable. To complete the 
calibration, press and hold the ENT key for two seconds. During this time 
a bar graph will progress across the lower display. The analyzer will then 
recalibrate and display CO2 recalibrated and then return to normal run 
mode. The display will now correctly read the value of the first calibration 
gas. NOTE: If the ENT key is released before two seconds have 
elapsed, the recalibration will be aborted and when the analyzer 
eventually returns to run mode it will use the existing calibration.

3. The analyzer should ideally be calibrated at normal ambient pressure. 
If the pressure correction mode is set to AUTO then it is still possible to 
perform an accurate calibration at pressures other than ambient. However 
above 25 mbar (gauge) or below -25 mbar (gauge) the display will flash 
and P? will display to warn that the pressure is either above or below the 
range recommended for accurate calibration.

4. The analyzer predicts the correct signal from the sensor during calibration 
and if this is outside the range of expected values then the display will 
flash and display G? to warn that either the cal gas flowing over the 
sensor is different to the value that has been programmed OR the sensor 
may be old and approaching the end of its life. Check before proceeding!

5. Repeat this procedure with the second calibration gas.

6. If at any time, difficulties are encountered and the machine needs to 
be restored to its factory set calibration, use the configuration software 
provided and load the default settings. Each machine is provided with a 
unique file that contains the factory settings. This is located on the CD-
ROM provided and is copied onto a PC during the installation process.

NOTE: A FULL calibration must be performed to achieve good accuracy. 
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7 GOOD MEASUREMENT PRACTICE

7.1 Sampling Hints

Ensuring reliable and accurate moisture measurements requires the correct sampling 
techniques, and a basic understanding of how water vapour behaves. This section aims 
to explain the common mistakes and how to avoid them.

Sampling Materials – Permeation and Diffusion

All materials are permeable to water vapour since water molecules are extremely 
small compared to the structure of solids, even including the crystalline structure of 
metals. The graph below demonstrates this effect by showing the increase in dew point 
temperature seen when passing very dry gas through tubing of different materials, 
where the exterior of the tubing is in the ambient environment.

Figure 9 Material permeability comparison

What this demonstrates is the dramatic effect that different tubing materials have on 
the humidity levels of a gas passed through them. Many materials contain moisture 
as part of their structure and when these are used as tubing for a dry gas the gas 
will absorb some of the moisture. Always avoid using organic materials (e.g. rubber), 
materials containing salts and anything which has small pores which can easily trap 
moisture (e.g. nylon). 

As well as trapping moisture, porous sampling materials will also allow moisture vapour 
to ingress into the sample line from outside. This effect is called diffusion and occurs 
when the partial water vapour pressure exerted on the outside of a sample tube is 
higher than on the inside. Remember that water molecules are very small so in this 
case the term ‘porous’ applies to materials that would be considered impermeable in 
an everyday sense – such as polyethylene or PTFE. Stainless steel and other metals 
can be considered as practically impermeable and it is surface finish of pipework that 
becomes the dominant factor. Electropolished stainless steel gives the best results over 
the shortest time period.

Take into consideration the gas you are measuring, and then choose materials appropriate 
to the results you need. The effects of diffusion or moisture trapped in materials are 
more significant when measuring very dry gases than when measuring a sample with a 
high level of humidity. 
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Temperature and Pressure effects

As the temperature or pressure of the environment fluctuates, water molecules are 
adsorbed and desorbed from the internal surfaces of the sample tubing, causing small 
fluctuations in the measured dew point. 

Adsorption is the adhesion of atoms, ions, or molecules from a gas, liquid, or dissolved 
solid to the surface of a material, creating a film. The rate of adsorption is increased at 
higher pressures and lower temperatures.

Desorption is the release of a substance from or through the surface of a material. In 
constant environmental conditions, an adsorbed substance will remain on a surface 
almost indefinitely. However, as the temperature rises, so does the likelihood of 
desorption occurring.

Ensuring the temperature of the sampling components is kept at consistent levels is 
important to prevent temperature fluctuation (i.e. through diurnal changes) continually 
varying the rates of adsorption and desorption. This effect will manifest through a 
measured value which increases during the day (as desorption peaks), then decreasing 
at night as more moisture is adsorbed into the sampling equipment.
 

Dew Point > T Dew Point < T

If temperatures drop below the sample dew point, water may condense in sample 
tubing and affect the accuracy of measurements.

Maintaining the temperature of the sample system tubing above the dew point of the 
sample is vital to prevent condensation. Any condensation invalidates the sampling 
process as it reduces the water vapour content of the gas being measured. Condensed 
liquid can also alter the humidity elsewhere by dripping or running to other locations 
where it may re-evaporate.

Although ambient pressure does not change drastically in a single location, the gas 
sample pressure does need to be kept constant to avoid inconsistencies introduced 
by adsorption or desorption. The integrity of all connections is also an important 
consideration, especially when sampling low dew points at an elevated pressure. If 
a small leak occurs in a high-pressure line, gas will leak out, however, vortices at the 
leak point and a negative vapour pressure differential will also allow water vapour to 
contaminate the flow.
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Theoretically flow rate has no direct effect on the measured moisture content, but 
in practice it can have unanticipated effects on response speed and accuracy. An 
inadequate flow rate may:

• Accentuate adsorption and desorption effects on the gas passing through 
the sampling system.

• Allow pockets of wet gas to remain undisturbed in a complex sampling 
system, which will then gradually be released into the sample flow.

• Increase the chance of contamination from back diffusion. Ambient air 
that is wetter than the sample can flow from the exhaust back into the 
system. A longer exhaust tube can help alleviate this problem.

• Slow the response of the sensor to changes in moisture content.

An excessively high flow rate can:

• Introduce back pressure, causing slower response times and unpredictable 
changes in dew point

• Result in a reduction in depression capabilities in chilled mirror instruments 
by having a cooling effect on the mirror. This is most apparent with gases 
that have a high thermal conductivity such as hydrogen and helium.

System design for fastest response times

The more complicated the sample system, the more areas there are for trapped moisture 
to hide. The key pitfalls to look out for here are the length of the sample tubing and 
dead volumes. 

The sample point should always be as close as possible to the critical measurement 
point to obtain a truly representative measurement. The length of the sample line to the 
sensor or instrument should be as short as possible. Interconnection points and valves 
trap moisture, so using the simplest sampling arrangement possible will reduce the time 
it takes for the sample system to dry out when purged with dry gas.

Over a long tubing run, water will inevitably migrate into any line, and the effects of 
adsorption and desorption will become more apparent. 

Dead volumes (areas which are not in a direct flow path) in sample lines, hold onto 
water molecules which are slowly released into the passing gas. This results in increased 
purge and response times, and wetter than expected readings. Hygroscopic materials 
in filters, valves (e.g. rubber from pressure regulators) or any other parts of the system 
can also trap moisture. Plan your sampling system to ensure that the sample tap point 
and the measurement point are as close as possible to avoid long runs of tubing and 
dead volumes.

Filtration

All trace moisture measurement instruments and sensors are by their nature sensitive 
devices.  Many processes contain dust, dirt or liquid droplets. Particulate filters are 
used for removing dirt, rust, scale and any other solids that may be in a sample stream. 
For protection against liquids, a coalescing or membrane filter should be used. The 
membrane provides protection from liquid droplets and can even stop flow to the 
analyser completely when a large slug of liquid is encountered, saving the sensor from 
potentially irreparable damage.
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Appendix A Technical Specifications

Specifications
Monitor
Operating Temperature +5 to +35°C (+41°F to +95°F)
Warm-Up Time 3 to 4 minutes @ +20°C (+68°F)
Maximum Inlet Temperature +50°Cdp (+122°Fdp)
Sample Flow Rate 0 to 1.2 Nl/min, user-selectable with pump 
Display

XGA301A1/A2
XGA301A3

16 x 2 character (9mm) back-lit LCD
20 x 4 character (9mm) back-lit LCD

Sample Connections

Standard - 4mm ID / 6mm OD nipple — gas fittings
on front panel
Optional - Rectus or Swagelok 6mm fittings.
Rear panel fittings for XGA301A1 only

Dimensions (H x W x D)                          
                                               XGA301A1

Panel-mount XGA301
XGA301A2/A3

290 x 250 x 250mm (11.4 x 9.8 x 9.8")
4U (177) x 300 x 290mm
195 x 355 x 340mm (13.8 x 10.4 x 5.9")*

Weight
XGA301A1

XGA301A2/A3
3.5 kg (7.7 lbs)
4 to 5.5 kg (8.8 to 12.1 lbs)

Electrical Specifications

Analog Outputs

2x 4-20mA outputs, assignable to any of the fitted 
sensors. 
2x alarm relays
2 x 0–10 V (XGA301A1 only)
2 x 0–5 V (XGA301A2/A3 only)

Digital output: RS232 ASCII
Power Supply: 90–260 V AC, 50/60 Hz

* Maximum dimensions including needle valve and with the feet extended.
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Sensor Options and Specifications

Sensor Type Zirconia Electrochemical Infrared

Measurand O2 O2 O2 (Low 
range)

CO CO (H2 
present)

CO2 CH4 CO

Accuracy ±1% of reading 
(logarithmic scale) or 
0.5ppm whichever is 
greater.

±1% of 
full scale 
at 25°C 
1013mbar

±2% of full scale at 25°C 1013mbar ±2% of full scale at 25°C 1013mbar

Inlet 
Pressure

1barg max 0.7 – 1.4bara 0.7 – 1.4bara

Response 
Time

Approx 5 seconds for a 
90% step change
(gas flow rate of 1 Nl/
min-1)

Approximately 30 seconds (T90) Approximately 30 seconds (T90)

Stablility ±2% of reading per 
month

±2% of range (over 12 months)

Life 
Expectancy

>17,500 hours ~10yrs ~10yrs

0-100%   

0-30% 
Note: Output can 
be user configured 

0-100ppm, up to 0-30%

   

0-10%   
0-5%  
0-3%  
0-1%  
0-5000ppm   
0-2000ppm    
0-1000ppm   
0-500ppm   

Sensor Type Water Dew Point* Pressure (2m lead), 
remote sensor

Accuracy ±2°Cdp of reading <±0.25% of full scale 
standard, enhanced 
accuracy of 0.1% and 
0.05% available at extra 
cost

Ranges -65 to +20°Cdp
-100 to +20°Cdp

0-5 barg
0-10 barg

*For full specifications, see the Easidew Transmitter datasheet



XGA301 User’s Manual

36   97487 Issue 2.1, October 2018

APPENDIX B

Appendix B

Application Software 
Installation and Operation



XGA301 User’s Manual

Michell Instruments  37

APPENDIX B

Appendix B Application Software Installation and Operation

B.1 Application Software Installation

It is possible to programme a range of variables to the XGA301 using an RS232 link with a PC 
running MS-Windows (all versions) and the supplied XGA301 software. The software is installed 
automatically by inserting the XGA301 CD into the CD-ROM drive. If auto-installation does not start 
then click the Windows START button and select RUN. Type X:\setup.exe where X is the drive letter 
of the CD. Alternatively access the CD from Windows Explorer or the ‘My Computer’ icon on your 
desktop, and double-click on the ‘Setup.exe’ programme. Follow the on-screen instructions to install 
the programme onto the hard drive. Once installed, access the programme by clicking START - 
PROGRAMS – XGA301 Software.

The software has been tested successfully on most language machines including Chinese, Korean & 
Japanese and all current versions of Windows operating system. We do not recommend the use of 
Vista as the unit will not communicate successfully with this operating system.

Note that software is ‘regionally aware’ and will therefore accept and display data using the decimal 
separator that is set in the PC’s Regional Settings in the Control Panel. For example, in the UK or 
US, you might enter the value 2.5 - in continental Europe this would normally be entered as 2,5 
assuming the PC’s Regional Settings have been set up to use ‘,’ as the decimal separator.

B.2 Start-Up

Make sure that the XGA301 is connected to a free serial port on the rear of your computer. These 
will nearly always be COM1 or COM2 but the software will scan through the ports until it finds the 
XGA301. The analyzer must be switched on for this to succeed and while communicating with it. On 
start up the software will locate the XGA301 and display the following page. 

 

Figure 10 Configuration Screen
NOTE: The actual values used may differ from those shown above.

The yellow status box at the bottom will display confirmation that the XGA301 was found and the 
result of the last action, or any error messages if there is a problem with communication. If you 
experience problems check that your serial cable (supplied) is correctly fitted to a valid serial port. 
Also check the status of your COM port settings in Device Manager accessed by clicking START – 
Settings - Control Panel.
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B.3 On-Screen Help

Access the on-screen help facility at any time by clicking on the help menu on the menu bar and 
select the ‘Help’ option or press F1.

B.4 Configuration Page

The configuration page is split into three. Switch between them by clicking on the tabs labelled “Config 
1”, “Config 2” or “Alarm Config”. Each page allows the user to reprogram an array of variables used 
by the XGA301. Once written to the XGA301, the new variables remain permanent until overwritten.

To read the current configuration stored in your XGA301 select ‘Read Analyzer Configuration’ from 
the ‘File’ menu, or click the ‘Read’ button on any of the ‘Config’ pages. Note that the entries in the 
boxes on the RHS (under the ‘Write’ button) will turn red if the value is different to that just read 
and a red asterisk will appear next to the ‘Write’ button to warn that a change has been made. The 
left-hand set of grey text fields (‘read fields’) will be updated with the current configuration data. To 
save this information (e.g., if several people share the same instrument) click the long copy (‘>>’) 
button (between the ‘Read’ and ‘Write’ columns) on any of the ‘Config’ pages in order to transfer the 
data into the edit boxes, select ‘Save Configuration as’ from the ‘File’ menu and choose a filename. 
This data set can be subsequently reloaded at any time by selecting ‘Load Configuration File’ from 
the ‘File’ menu and then selecting the folder where the configuration files have been stored.

If at any time you wish to restore the machine to its factory default settings select ‘Default 
Configuration’ from the ‘File’ menu to load these values. The software will search for a unique ‘.rxc’ 
file that is loaded onto the PC during the software installation. The filename is 2100***.rxc where 
*** is the last three digits of the serial number located on the rear of the machine. This file is also 
located on the CD-ROM that came with the machine. Normally this file is located in “My Documents” 
directory but if the software cannot locate it then it will ask for the serial number to help it search. 
With the correct rxc file loaded into the ‘Read’ columns, simply click ‘>>’ (copy) to transfer the 
defaults into the edit boxes and then click any of the three ‘Write’ button to load them back into the 
XGA301.

The right-hand set of white editable text fields (‘write fields’) is used to enter new values to be 
programmed into the XGA301. The values in these fields can either be entered manually, or copied 
across from the ‘read fields’ by clicking the vertical ‘Copy’ button, and then edited as required, 
however greyed boxes under the ‘Write’ buttons are not editable as they contain calibration data; 
they can only be changed by copying data across from the ‘Read’ fields. Note that when you click 
on the copy button all three ‘Config’ pages are updated at the same time and there is no need to 
repeat the action when you toggle to the other page. Alternatively, you can load saved configuration 
data by selecting ‘Load Configuration’ from the ‘File’ menu and selecting the required file. In order 
to programme the analyzer select ‘Write configuration to the analyzer’ from the ‘File’ menu, or click 
the ‘Write’ button on any ‘Config’ page.
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B.5 Reconfiguring the Analyzer

The on-screen edit boxes contain variables that can be reprogrammed into the XGA301 in exactly 
the same manner as using the front panel keypad. For a full description please refer to the relevant 
section in this manual.

The user can choose whether to use ppm or percent notation to edit the text boxes, where appropriate, 
by selecting the ‘UNITS’ menu and clicking on ‘Percent’ or ‘ppm’. To access a field, either click inside 
it or use the TAB key to scroll through them. The field parameters are as follows:

B.6 Configuration 1 Screen

1. Oxygen Range: Not available for the XGA301.

2. Oxygen Units & Format: See Section 2.12 for a full description. Use the 
drop down box to select PPM EXPONENTIAL, PPM MIXED, AUTO%/PPM, 
PRESSURE or N2 BALANCE. The default setting is AUTO%/PPM.

3. Oxygen Analog Output Mode: See Section 2.11 for a full description. 
Use the drop down menu to select RAW, LIN(ppm) or LOG(ppm) as 
the mode of output for the 4-20 mA and 0-10 V signals. The default is 
LIN(ppm).

4. Temperature Units/Enable: Not available for the XGA301.

5. Pressure Units: See Section 2.12 for a full description. Use the drop 
down menu to select MBAR, KPa, TORR, BAR or PSI as the unit for 
pressure measurement. The default setting is MBAR.

6. Pressure Correction Mode: See Section 2.14 for a full description. 
Use the drop down menu to select NONE, AUTOMATIC or MANUAL. The 
default setting is NONE.

7. Operating Mode: Not available for the XGA301.

8. Auxiliary Output Parameter: Not available for the XGA301.

9. LCD Refresh interval: Use the drop down menu to select a refresh rate 
for the LCD (min 0.1, max 1.5 sec). The default is 0.3 seconds.

10. LCD Second Line Option: See Section 2.13 for a full description. Use 
the drop down menu to select PRESSURE or NONE.

11.  Pump Flow Rate: See Section 2.6 for a full description. Use the drop 
down menu to select a pump flow value from 10-100% or OFF. The default 
is 100%.

12. Password option: See Section 2.7 for a full description. The password 
is factory disabled and set to 0000. Use the drop down menu to enable 
or disable the password feature and the password box **** can be used 
to enter a new password. Note that you will be prompted to enter the 
original password to make changes to the password or its status.
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B.6.1 Configuration 2 Screen

 

Figure 11 Configuration 2 Screen

NOTE: The actual values used may differ from those shown above.

1. Calibration Gas 1, 2 & 3: These boxes are greyed out in this version 
and the data is for information purposes only. If you want to change the 
current calibration gas then follow the procedure given in Section 3.

2. Calibration Constant A B & C: These boxes contain the calibration 
constants that the XGA301 calculates automatically when you perform a 
calibration. You will see that they change each time you perform a new 
calibration. Generally the air value should be approximately -10 mV and a 
low ppm value (e.g. 10 ppm) would be approximately 180 mV.

3. O2 Analog Output (0 V/4 mA & 10 V/20 mA): Use these two boxes 
to set the High and Low oxygen values for the analog outputs (6) on the 
rear panel. For example if you want 4 mA to represent 1% and 20 mA to 
represent 21% then enter these two values into the appropriate boxes. The 
value can be entered either in % or ppm depending on the units selected. 
The default is %. The default values are 25% for the high setting and 
0.001% for the low setting.

4. Auxiliary Analog Output (0 V/4 mA & 10 V/20 mA): Use these two 
boxes to set the High and Low auxiliary (e.g. pressure sensor) values for the 
analog outputs (6) on the rear panel. For example if you want 0 V/4 mA to 
represent 0 mbar and 10 V/20 mA to represent 100 mbar then enter these 
two values into the appropriate boxes. The units are fixed in mbar.

5. Absolute Ambient Pressure: Use this box if you want to enter the 
current ambient pressure (in mbar). This value is used in the automatic 
pressure correction function only and provides enhanced accuracy in 
the correction. The default is 1013 mbar which is the average ambient 
pressure in the UK.
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B.6.2 Alarm Configuration Screen

 

Figure 12 Alarm Configuration Screen
NOTE: The actual values used may differ from those shown above.

1. Alarm Source: Use the drop down box to assign a detector to the alarm. 
If you want the alarm to be based on oxygen readings select oxygen from 
the drop down list. The choices are: oxygen, pressure or temperature.

2. Alarm Outputs: This option enables or disables the alarms on the rear 
panel (labelled Alarm High +/- and Alarm Low +/-). Make sure these are 
enabled if you wish to use the signals from the alarm circuit.

3. Audible Alarm: This option enables or disables the audible buzzer fitted 
to the XGA301 internally. When an alarm condition occurs the buzzer will 
emit a continuous noise to alert the operator.

4. Visible Alarm: This option enables or disables the visual warning on the 
front LCD. When enabled and an alarm condition occurs the message AL1 
or AL2 will flash in the lower right hand corner.

5. Rising or falling Alarm: This option allows the alarm to be set as a 
rising or falling type. If the alarm is rising then the reading must rise 
above the set-point for the alarm to be activated. If the alarm is falling 
then the reading must fall below the set-point for the alarm to activate.

6. Contacts N/O or N/C: This option allows the user to programme how 
the relay contacts are set on the rear panel. Normally Open means that 
the contacts are open circuit when an alarm is not activated and Normally 
Closed means that the contacts are closed when the alarm is not activated.

7. Alarm Setpoints: Use this box to programme the set-point value at 
which you want the alarm to activate. The units are in %, ppm or mbar 
depending on which sensor as been assigned to the alarm.
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Once you have finished editing the parameters, select ‘Write Configuration to Analyzer’ from the file 
menu and the new data set will be written to the XGA301. The XGA301 is reprogrammed using the 
new configuration. The software then reads the new settings back from the XGA301 and displays 
them in the boxes on the left-hand side confirming that the configuration was successful. When 
you have finished programming the analyzer for new calibration gases the instrument must be re-
calibrated to benefit from the changes.

B.7 On-Screen LCD

It is possible to display an LCD emulator on the desktop of your PC. This reproduces exactly the 
display on the XGA301 unit and is convenient if you are some distance away from the machine. To 
activate the LCD select the UTILITIES menu and select the LCD on option. This will display a small 
window showing the LCD that can be positioned independently anywhere on the desktop.

 

Figure 13 On-Screen LCD

The blue LED indicator will flash to show that the display is updating.

B.8 Remote Calibrating and Cleaning

With the on-screen LCD display active it is possible to remotely calibrate the analyzer and clean the 
sensor. Click on the down arrow icon in the bottom right-hand corner of the LCD display to expand 
the window:

 

Figure 14 Remote Calibration and Clean Function

Use the four buttons to calibrate or clean the sensor directly from the PC. Before calibrating the 
analyzer with gas, make sure that you know the exact O2 concentration in your gas bottle AND you 
have a calibration certificate from the gas supplier confirming the concentration. You can calibrate 
the analyzer in any order but remember that the gas value for O2 HIGH must be greater than the 
gas value for O2 MIDDLE, which must be greater than the gas value for O2 LOW. Allow sufficient 
time for the calibration gas to pass over the sensor and let the reading on the LCD stabilize. This is 
extremely important to perform a successful and accurate calibration.
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The software uses the three calibration gas values already stored in the XGA301 as a starting point. 
These are typically High = 20.95%, Middle = 0.1% and Low = 0.001% as set in the factory but may 
be different if the user has recalibrated with other gas values in the past. Either way you are given 
an option to change the cal gas value before proceeding to the actual calibration.

Assuming you are using fresh air (20.95%) to calibrate O2 HIGH then simply click on the button 
labelled "Calibrate High O2" to see the following:

 

Figure 15 Calibration Gas Confirmation Screen

If the current stored value is correct and matches your cal gas value then simply click “Yes” to 
proceed. If you are using a different value to the one you see on the screen then click “No” to change 
it as shown below:

 

Figure 16 Calibration Gas Update Screen

Enter your new value in the units as instructed and click “OK” to proceed. This value will then be 
stored until you want to change it again. You will now see the following screen:

 

Figure 17 Calibration Confirmation Screen

This is your final chance to change your mind before committing to a calibration. Check carefully 
that the gas value on the screen actually matches the value of your calibration gas before clicking 
on “Yes” to complete the calibration. At this point you should observe that the LCD display will reset 
itself to the correct calibration. You can now proceed with the rest of the calibration process by 
selecting the Middle and Low gases in the same manner.
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B.9 Calibration Error Messages

During the calibration process described in Section 3 it is possible to receive screen error messages 
as described here.

1. Bad Sensor Reading: The XGA301 software makes a prediction of the 
expected sensor mV for each calibration gas value entered. If the mV 
signal coming from the sensor is out of the expected range the following 
message is displayed:

 

This normally indicates one of two things: that you are using the wrong 
cal gas value compared with the actual gas fl owing over the sensor OR the 
sensor is getting old and can no longer output the expected signal required 
for a healthy calibration.

2. Bad Pressure Reading: The XGA301 software checks to see what the 
gas pressure is before allowing the calibration to continue. If the pressure 
is outside the range -25 mbar to +25 mbar (gauge) then the following 
message is displayed:

 

This normally indicates that you are allowing gas from a cylinder set at too 
high pressure to enter the analyzer. Try displaying the pressure reading on 
the second line of the LCD and adjusting the gas regulator to trim it close to 
0 mbar. If you are using a standard gas regulator then try switching off the 
sample pump on the rear of the analyzer OR better still use a demand fl ow 
regulator and allow the gas to enter the analyzer from the draw of the pump.

NOTE: The above are only advisories and you can proceed with the 
calibration if you believe everything is checked and correct.
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B.10 Software Utilities

The utilities menu is located on the main file menu as shown below:

 

Figure 18 Software Utilities Menu Screen

B.10.1 Setting Analyzer Date and Time

The current date and time of your PC are displayed on the configuration screen and can be loaded 
into the XGA301 by selecting the Utilities menu and clicking the ‘Set date and time’ option. This 
information is used in the RS232 data string for data logging purposes. Make sure that your PC clock 
is set correctly before using this function, as you cannot edit the date and time shown by the XGA301 
software. The date and time formats displayed are those set in the PC’s Regional Settings.

B.10.2 Check for Updates

This function will check online and advise you if any software updates are available for your machine. 
This function is not automatic. To update the software you need to visit www.michell.com and select 
the support page where a list of downloads are provided.

B.10.3 Image Grabber

This is a simple function to allow the user to copy the software screens into the Windows clipboard. 
This is useful for diagnosing problems; allowing a quick and simple way of sending the Michell 
Instruments' technicians actual screen shots of the software. To recover the images simply press 
CTL+V to paste.

B.11 Operation

The XGA301 software includes a full data logging facility. Data can be saved to a file automatically 
at regular intervals and the format is compatible with modern spreadsheet programmes such as MS-
Excel. A live-time graphing facility is also included which has many powerful features. Note that the 
data logging facility will only function if the analyzer is in NORMAL run mode.
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B.12 Setting up the Data Logger

Click on the tab labelled ‘Data Acquisition’ to display the following page:

 

Figure 19 Data Logging Page

During logging, data from the analyzer is shown in the central area of this page. The data is displayed 
in the following columns: time (in seconds), the raw signal from the sensor (in mV), the oxygen value 
(in ppm scientific notation), pressure in the units of choice, the time (in regional format), the date (in 
regional format), and alarm status (displays either ALM1, ALM2 or ALM1&2 if activated).

To start data logging select the frequency of measurement by entering a time and selecting a unit 
from the drop down list. For example if you wish to log data once every minute type 1 in the box and 
select ‘Mins’ from the drop down menu.

The NOTES window can be opened at any time by selecting NOTES from the ‘Data Logger’ drop 
down menu. A small text box appears in which you can type a text message. This note is then saved 
as a header in the data file set and can be viewed along with the data.

Choose to have data logged continuously until ‘Stop’ is selected from the Data Logger menu, or 
choose to set a time limit for data logging by checking the box labelled ‘Time Limit’, setting the 
duration in the ‘Run For’ box and selecting units with the drop down list. For example if you wish to 
log data for thirty minutes type ‘30’ in the box and select ‘Mins’ from the drop down list.
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B.13 Running the Data Logger

If you wish to save the data into a file for later use, check the ‘Save to File’ box before selecting ‘Run’ 
from the Data Logger menu. You will be prompted for a file name and location before data logging 
commences. The file and path information will appear in the box at the top of the page labelled ‘Data 
File Name’. If you forget to select file saving before starting a run, you will nevertheless be prompted 
at the end as to whether you wish to save the run data.

The blue progress bar displays the state of completion of the run, and the blue box to the right of 
it the same information as a percentage. You can stop the run at any time by selecting ‘Stop’ from 
the Data Logger menu. The yellow Status bar at the bottom of the page gives information about the 
data logging operation.

Once data logging is complete you may open the text format data file using any compatible 
spreadsheet programme such as MS Excel, and use the data to generate plots and reports.

You can pause the data logger at any time by selecting ‘data logger’ and ‘pause’. Repeat to continue 
logging from where you left off, noting that the clock keeps ticking during the pause period.

B.14 Auto Date Stamped Files

If you are planning to run the data logger for extended periods of time then you should consider 
checking the ‘Auto date stamped file’ option. This feature will save the data at midnight for the 
previous twenty four hours and so on until the data-logging is complete OR the user interrupts. The 
data file is stored with a date suffix in brackets in yy-mm-dd format.

This feature ensures that data is saved periodically in sensible sized files. This will prevent the 
computer from crashing and will also ensure that the data is small enough to fit into an Excel 
spreadsheet

As an example, the user wishes to run the data-logger for seven days recording every minute starting 
at lunchtime on 12th November 2005. He starts the data logger with the auto-date stamp function 
enabled. When prompted he gives the filename as test1. In this situation the data logger will run 
from lunchtime to midnight and then save the first file as test1 (2005-11-12). The data logger then 
clears and continues for another twenty four hours until midnight the following day. The data is then 
stored as test1 (2005-11-13). This will continue for seven days when the data-logger will finish.

After this the user will have a sequence of files:

test1 (2005-11-12).txt
test1 (2005-11-13).txt
test1 (2005-11-14).txt    and so on

Combined together they represent all the data over the last seven days. Note that the XGA301 
uses the computer clock and date to perform this action, so make sure that they are correct before 
starting a run.

To view the data in its entirety the user would need to load each file in turn back into Excel to 
combine.
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B.15 Live Time Graphing Screen

The XGA301 data-logging package includes a live-time graphing facility that allows you to monitor 
the progress of your data in a graphical format (see below). To access the graph check the box 
labelled ‘Show Graph’. The graph will appear in a new window, and can be accessed at any time 
without disturbing a run that is already in progress. You can select ‘Run’ and ‘Stop’ from the Data 
Logger menu to begin and end data logging, and the window can be minimized to (and restored 
from) the task bar while logging data. 

To close the window and return to the main data-logging page select ‘Close Plot’ from the File menu 
or click on the close window button.

The features of the graph window are described below:

 

Figure 20 Live Time Graphing Screen

B.16 Main Graph Window

The graph is an XY plot, with time plotted on the X-axis, oxygen plotted on the primary Y-axis (Y1) 
and pressure plotted on the secondary Y axis (Y2). The X-axis and the two Y-axes auto-scale during 
data logging so that all data points are shown on the graph.
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B.17 Plot Colors

The default colors used on the graph are set to blue for oxygen and red for pressure. To change 
the colors double-click on the colored axis label at the top of each axis. A color palette window will 
appear (see Figure 20) and a new color can either be chosen from a color box, or for more variety, 
by clicking the ‘Define Custom Colors >>’ button. Click on ‘OK’ to select the new color or ‘Cancel’ to 
return to the graph without change.

 
Figure 21 Plot Color Palette Menu

B.18 Graph Titles and Labels

If you want to change the text of the graph axis labels, place the mouse pointer over the text and 
do a single left click to enter edit mode. The text can then be modified. Similarly, to change the 
title of the graph, place the mouse pointer over the title and click once to edit. If you choose not to 
enter a title the graph will display the path and filename of the run as the new title once the run has 
finished. Note that these changes are only temporary and will be overwritten by the defaults if a new 
run is started or the graph window is closed and reopened. They are provided so that the plot may 
be printed with alternative labels.

B.19 Plot Co-ordinates

The box labelled ‘Plot co-ordinates’ to the upper left of the graph window displays the actual plot co-
ordinate value at the mouse pointer. This can be used to get a quick oxygen value from the graph. 
Simply place the mouse pointer at a place of interest and read the corresponding X1 and Y1 values 
in the box.

B.20 Last data point

During data acquisition, the box labelled ‘Last data point’ will appear at the upper middle of the 
graph window. It displays the last data values read from the analyzer.
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B.21 Using the Cursor

Clicking and holding the left mouse button with the pointer over the ‘C’ at the top of the plot area 
activates the cursor, which appears as a vertical dashed line on the plot. While keeping the mouse 
button pressed, you can now move the pointer anywhere in the plot area or on the ‘C’ in order to 
move the cursor. The box labelled ‘Cursor’ to the upper right of the graph window will display actual 
values for oxygen, temperature, time and the data point number (n) at or immediately to the left 
of the cursor position. The cursor can be used to investigate actual data values at specific points of 
interest on the graph.

B.22 Zooming

You can zoom in to any part of the oxygen plot by simply placing the mouse pointer on the new 
graph start position and then clicking and dragging a new box to re-size the graph. The label on the 
box to the upper left of the graph window will change to ‘Zoom box co-ordinates’, and an extra set of 
co-ordinates, labelled X2 and Y2, will appear, showing the co-ordinates in X and Y units of the second 
corner of the zoom rectangle as you drag the mouse pointer. The plot will zoom and auto-scale when 
you release the mouse button. This can be repeated if you wish to zoom in even further. To zoom 
back to the original size select ‘Zoom Full’ from the View menu.

NOTE: Although you can use the zoom facility during a live run, the graph will auto-scale 
to full size with each new data point.

B.23 Y-Axis Graph Units

You can toggle the Y1 oxygen units at any time from percent to ppm and vice versa. Select ‘O2 Units’ 
from the View menu and chose either percent or ppm. The current selection is then displayed in the 
top right box labelled ‘O2 Axis’.

B.24 Oxygen Scale

You can display the Y1 oxygen axis in linear or logarithmic format at any time by selecting ‘O2 Scale’ 
from the view menu. The current selection is then displayed in the top right box labelled ‘O2 Axis’. 
Note that the zoom function is disabled when you are viewing on a log scale.

B.25 Second Y Axis

The secondary Y axis located on the right hand side of the graph can be used to display the pressure 
taken from the internal pressure sensor. The axis is linear and auto-scaling. To select the mode of the 
secondary axis select ‘view’ and then ‘second axis display’. Choose from ‘none’ or ‘pressure’.

B.26 Loading an Old Run

A previously logged data file can be loaded and viewed by selecting ‘Open Data File’ from the File 
menu and selecting the appropriate TXT or CSV file. A progress bar is displayed while the data is 
being imported. Note that very large data files may take several seconds to load. The data is re-
graphed and you can zoom, label axes, change colors etc., before printing the graph.
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B.27 Printing Graphs

You can print the graph at any time by selecting ‘Print Plot’ from the File menu. This will bring up 
the printer dialogue box for your specific printer where you can chose various printing options. Make 
sure that the printer page is set to landscape to obtain a full size print out.

B.28 Data Logging in the Background

It is possible to begin data logging and then minimize the windows to continue working with another 
application. To minimize the graph simply click on the minimize button on the blue title bar at the 
top of the window. You can then use the ALT + TAB keys to take you to other programmes already 
running. To return to the graph simply maximise from the start menu bar or press ALT + TAB again. 
If the graph does not redraw immediately select ‘Zoom Full’ from the View menu to redraw.

B.29 Pausing the Data Logging

You can pause the data-logging at any time during the run by selecting the ‘data logger’ menu and 
selecting ‘pause’. Repeat the action to continue, noting that the live graph will draw a straight line 
between the paused points to keep continuity of the axes. The clock keeps ticking during the pause 
period.

If you decide to access the menu of the XGA301 using the front keypad during data logging, then 
the software will pause automatically. A message appears on the screen informing the user that the 
unit is being accessed from the keypad. Once the menu has been exited, the software will continue 
data logging from where it left off.

B.30 Changing the Data Logging Parameters Mid-Run

Once the data logging has begun you may change the sample interval time by pausing the data 
logger and then entering a new value for the time interval. The data logger can then be resumed 
with the new values in place. NOTE: Units (e.g. seconds to hours) cannot be changed once 
logging has started. If you originally selected seconds then you may change the current value to 
a new value between 1 and 3600 seconds, if you originally selected minutes then you may change 
between 0.02 and 360 and if you selected hours you may change between 0.01 and 6 hours. 

NOTE: It is not possible to modify the original total length of time that the data logging 
will run for once a run has commenced.

B.31 Working with Spreadsheets

The data-logger saves data files in a standard comma separated ASCII text format which can be 
readily imported into spreadsheet programmes such as MS Excel, in order to produce plots and reports 
as desired. For specific information on how to import text files into your spreadsheet programme 
please refer to the help guide supplied with the programme.

Data is saved in comma separated value format, with a ‘.txt’ file extension as the initial programme 
default. However, when entering the file name, you can instead select a ‘.csv’ extension: the 
programme will register the last used file extension as the new default. The ‘.csv’ extension is 
recognised by MS Excel, so that opening the file will automatically run MS Excel, and this may be of 
benefit if your regional decimal separator is period ‘.’ rather than comma ‘,’. However, if your decimal 
separator is comma, you should continue to use the ‘.txt’ extension and open the file explicitly from 
within your spreadsheet programme, defining the field delimiter as ‘comma’ where appropriate.
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B.32 Disaster Recovery

To prevent catastrophic loss of important data during a computer crash or power failure, the data is 
automatically saved point by point in a temporary file called ‘XGA301 temporary data file 2100xxx.
txt’, where 2100xxx is the serial number of your XGA301. This file is located in the same directory 
as the main XGA301 programme itself and can be renamed or copied to recover data that would 
otherwise be lost. Note that this file is overwritten each time ‘Run’ is selected from the ‘Data Logger’ 
menu so make sure all data is recovered successfully before starting another run.

NOTE: During a run using the ‘auto date stamped’ feature, the temporary data file is 
wiped clean as soon as the previous data set has been saved successfully. In the case 
of a crash the temporary data file should be used to recover the last day’s worth of data 
that was not saved to the hard disc.

B.33 Diagnostics

The XGA301 software includes a diagnostics page that is accessed from the tab labelled ‘Diagnostics’. 
This screen will display various values and settings that are operating inside your machine. There is 
no editing possible on this page – it is purely for information and to enable technical support help 
you should you experience difficulties with your machine. You may be asked to record values from 
this page if troubleshooting is required.

 

Figure 22 Diagnostics Screen

1. Analog: The live analog values displayed in this pane are voltage 
measurements coming directly from the computer chip inside the analyzer. 
They are for information purposes only but are a useful diagnostics tool 
for Michell Instruments' staff, as unusual values can indicate a particular 
fault. To help diagnose a fault please capture this window as shown above 
using the screen capture function and e-mail it to info@michell.com. 
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2. Sensor State: These boxes should all indicate “OK” on a healthy analyzer. 
Note that the XGA301 does not have a temperature sensor fitted so all 
references to temperature on this screen are not relevant. The possible 
messages are “OK” “High” “Low” or “Fault”. The High and Low messages 
indicate that the sensor is out of normal range. The fault message will 
only display if the sensor is disconnected or has failed in some way.

3. Digital: The digital signals coming directly from the computer chip 
inside the analyzer can be monitored here. To test the keypad is working 
correctly try pushing the buttons and watching the panel. A correctly 
functioning key will turn the box red on the screen and the digital value 
for that particular key will show in the data box. If the analyzer has an 
external thermocouple correctly fitted (2100 and 3100 series only) then 
this will display a signal in the “Temperature Sensor” box.

4. Log Diagnostic Data: If you check this box then the software will 
automatically start to save a diagnostic file in the “My Documents” 
directory called “XGA301 diagnostics data XXXX.txt (where XXXX is the 
serial number of your machine). 

Note the following:

• Diagnostic data is logged every 6 seconds, or every second if your software 
has the "Enable fast log" check box.

• Logging diagnostic data is controlled entirely by the "Log diagnostic data" 
check box - logging starts as soon as it is checked, and stops when it's 
unchecked.

• If you switch to a different tab diagnostic data logging will be suspended, 
so the general rule when logging diagnostic data is check the "Log 
diagnostic data" check box and then leave the software alone until you 
want to stop logging.

• There is no file name option, so rename the last diagnostic data file 
before logging new diagnostic data.

• Diagnostic data contains raw data from the analyzer as well as either 
status messages (such as "Sensor heating") or acquisition data as you 
would get from the normal data acquisition file. However, unlike normal 
data acquisition, it isn't suspended if the heater loses control. Diagnostic 
data saving will only be suspended if there's a comms glitch between the 
PC and the XGA301, or if you try to interact with the XGA301 via software. 
The file is created at the start of the run, and as with the temporary data 
file, each data line is appended, so you can look at the file at any time. 
You can therefore have a look at the file at any time (for example by 
opening it in Notepad or by copying and saving it with a .CSV extension 
for Excel) and see whether there are any anomalies.

• E-mail the file to info@michell.com so we can help diagnose the problem.
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Appendix C

Troubleshooting
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Appendix C Troubleshooting

Q: The XGA301 says 'sensor heating' but won't begin measuring.

A: What kind of gas are you running over the sensor? Does it contain hydrogen or helium? If so 
then the heater may be struggling to heat the sensor with such cooling gas present. Does 
the problem go away if room air is allowed into the analyzer? Contact Michell Instruments 
for advice. If the message continues for around eight minutes then the analyzer will give 
up and indicate that the internal heater has failed and the sensor needs replacing.

Q: The XGA301 will not power up at all.

A: There are fuses located on the power socket on both live and neutral lines. These are 
standard 20mm 2A SLOW BLOW fuses available from a supplier such as RS Components.

Q: The XGA301 gives strange readings that are way off the expected values.

A: Check to make sure which calibration gases are selected. Are they the same as the actual 
gases you used to perform the calibration? If not you must recalibrate the analyzer or re-
load the factory defaults to get you going again. 

Q:  The sensor does not read 20.9 - 21.0% in air (actual value is 20.95%).

A: If the room air is very humid, it will slightly affect the observed measurement or the sensor 
may have drifted slightly because of natural ageing. If you are using air as a calibration 
point then simply do a quick re-calibration in the air to compensate for this.

Q:  I messed up the calibration procedure and the analyzer is not working properly.

A: Return the box to the factory defaults using the keypad or communications software, by 
selecting ‘Default Confi guration’ followed by ‘Write Confi guration to Analyzer’ from the File 
menu. Now try re-calibrating the XGA301.

Q:  The software will not talk to the XGA301.

A: Make sure that you are using the correct cable, as supplied (pin 2 to pin 2 etc). A crossed 
RS232 cable (pin 2 to pin 3 etc.,) will not work. Make sure that your COM ports are 
recognised by your computer. Check in your Windows device manager to see if there are 
any confl icts. If you are using a USB-Serial port adapter which does not have an FTDI 
chipset then you may encounter diffi culties. Contact us for advice!

Q:  I selected ‘Write to the Analyzer’ and now the XGA301 is way off calibration.

A: Only select ‘Write to the Analyzer’ once all the values are correctly entered in the boxes on 
the right. The best procedure is to ‘Read Analyzer Confi guration’ and then press ‘Copy’ so 
the values in the boxes are the same as those stored in the XGA301 memory. You can then 
edit these values and then select ‘Write to the Analyzer’ when fi nished.
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Q:  How do I get back to the factory calibration for my instrument.

A: Select ‘Load Confi guration File’ from the File menu and look for the rxc fi le on your CD. 
Select this fi le and then select ‘Write to the Analyzer’. This will load the factory calibration 
back into the XGA301. Alternatively you can load a standard default confi guration any time 
using the ‘Load Default’ option on the File menu. This confi guration will not be perfect for 
your analyzer but will be good enough to get you started again.

Q:  The H2O sensor takes a long time to respond .

A:  If the analyzer and sensor has been left exposed to air, which is normally quite humid, then 
it can take a long time for the dew-point tile to dry out once measurements commence. Try 
fl ushing the analyzer with dry nitrogen and when the unit is switched off please remove the 
inlet tube. This will trap the dry gas in the dew-point compartment.

C.1 Load Defaults (Zirconia Sensor only)

If a mistake is made while programming the XGA301 it is possible to restore the machine back to its 
factory settings by loading the unique default configuration that is supplied on the software CD-ROM. 
The default set-up can only be accessed using the software provided. See Appendix C for further 
details.

Alternatively, reset to generic factory defaults directly from the front panel keypad. Press the ENT 
key to enter the user setup menu and select menu option Load Defaults and press the ENT key to 
proceed. The next screen will say Load Defaults ? with the prompt to press and hold the ENT key 
for 2 seconds to confirm. To complete this - press the ENT key until the bar graph has completed 
and the screen says Defaults Loaded. This will give all the basic settings that are factory set. Re-
calibrate the sensor and check all the settings are suitable.
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C.2 Analog Output Settings and Alarm Status

XGA301A1

O2 Analog Outputs
Description Explanation Alarms 3Current 1 

(4-20 mA)
Voltage 2 
(0-10 V)

1 mA 0.625 V Fault

There is a sensor fault on the oxygen 
sensor, and/or the temperature sensor 
has a fault condition, and/or the pressure 
mode is set to automatic (pressure 
compensation active) and the pressure 
sensor has a fault condition.

De-activated

2 mA 1.25 V Start up The analyzer is still initializing. De-activated

2.5 mA 1.5625 V Sensor under 
range The sensor reading is under range. Active

3 mA 1.875 V Sensor over 
range The sensor reading is over range. Active

3.5 mA 2.1875 V

Sensor 
operating 

out of 
specification

The sensor reading is in range but the 
temperature sensor reading is out of 
range, and/or the pressure mode is set to 
automatic (pressure compensation active) 
and the pressure sensor is out of range.

Active

4 to 20 mA 0 to 10 V
Normal 

operating 
output

The O2 sensor and associated (1) 
sensor(s) are operating normally and 
readings are in range.

Active

Pressure Analog 
Outputs

Description Explanation Alarms 3
Current 1  

(4-20 mA)
Voltage 2 
(0-10 V)

1 mA 0.625 V Fault The pressure sensor has a fault. De-activated
2 mA 1.25 V Start up The analyzer is still initializing. De-activated

2.5 mA 1.5625 V Sensor under 
range

The pressure sensor reading is under 
range. Active

3 mA 1.875 V Sensor over 
range

The pressure sensor reading is over 
range. Active

4 to 20 mA 0 to 10 V
Normal 

operating 
output

The pressure sensor is operating normally 
and readings are in range. Active

Table 5 XGA301A1 Analog Output Settings and Alarm Status
Notes:

1 The current outputs are active self-powered outputs - they are not loop powered.

2 The voltage (0 to 10 V) outputs produce non-zero voltages during start-up, fault  
  and over/under range conditions - if 1 V to 5 V outputs are required, with these  
  conditions indicated by corresponding voltages between 0 V and 1 V, the current
  outputs can be used, with a 250 Ω load resistor.

3 Alarms are de-activated during start up initialization, and when a fault condition  
  occurs on the assigned sensor. 
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XGA301A2

O2 Analog Outputs
Description Explanation Alarms 3Current 1 

(4-20 mA)
Voltage 2 
(0-5 V)

1 mA 0.25V Fault

There is a sensor fault on the O2 sensor, 
and/or the pressure mode is set to 
automatic (pressure compensation active) 
and the pressure sensor has a fault 
condition.

De-activated

2 mA 0.5V Start up The analyzer is still initializing. De-activated

2.5 mA 0.625V Sensor under 
range The sensor reading is under range. Active

3 mA 0.75V Sensor over 
range The sensor reading is over range. Active

3.5 mA 0.875V

Sensor 
operating 

out of 
specification

The O2 sensor reading is in range but  
the pressure mode is set to automatic 
(pressure compensation active) and the 
pressure sensor is out of range.

Active

4 to 20 mA 0 to 5V
Normal 

operating 
output

The O2 sensor is operating normally and 
readings are in range.  If the pressure 
mode is set to automatic (pressure 
compensation active), then that is also 
working normally and its readings are in 
range.

Active

Aux Analog Outputs 4

Description Explanation Alarms 3Current 1  
(4-20 mA)

Voltage 2 
(0-5 V)

1 mA 0.25V Fault The assigned sensor has a fault or is 
missing. De-activated

2 mA 0.5V Start up The analyser is still initialising. De-activated

2.5 mA 0.625V Sensor under 
range

The assigned sensor reading is under 
range. Active

3 mA 0.75V Sensor over 
range

The assigned sensor reading is over 
range. Active

4 to 20 mA 0.875V
Normal 

operating 
output

The assigned sensor is operating normally 
and readings are in range. Active

Table 6 XGA301A2 Analog Output Settings and Alarm Status

Notes:

1 The current outputs are active self-powered outputs - they are not loop powered.

2 The voltage (0 to 5 V) outputs produce non-zero voltages during start-up, fault  
  and over/under range conditions - if 1 V to 5 V outputs are required, with these  
  conditions indicated by corresponding voltages between 0 V and 1 V, the current
  outputs can be used, with a 250 Ω load resistor.

3 Alarms are de-activated during start up initialization, and when a fault condition  
  occurs on the assigned sensor. 
4 The auxiliary sensor outputs can be assigned to CO or Pressure



XGA301 User’s Manual

Michell Instruments  59

APPENDIX D

Appendix D

Quality, Recycling
& Warranty
Information



XGA301 User’s Manual

60   97487 Issue 2.1, October 2018

APPENDIX D

Appendix D Quality, Recycling & Warranty Information

Michell Instruments is dedicated to complying to all relevant legislation and directives. Full information 
can be found on our website at:

www.michell.com/compliance

This page contains information on the following directives:

• ATEX Directive

• Calibration Facilities

• Conflict Minerals

• FCC Statement

• Manufacturing Quality

• Modern Slavery Statement

• Pressure Equipment Directive

• REACH

• RoHS2

• WEEE2

• Recycling Policy

• Warranty and Returns

This information is also available in PDF format.
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Decontamination Declaration
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Appendix E Return Document & Decontamination Declaration

       F0121, Issue 2, December 2011

IMPORTANT NOTE:  Please complete this form prior to this instrument, or any components, leaving your 
site and being returned to us, or, where applicable, prior to any work being carried out by a Michell 
engineer at your site.

Instrument Serial Number

Warranty Repair? YES NO Original PO #

Company Name Contact Name

Address

Telephone # E-mail address

Reason for Return /Description of Fault: 

Has this equipment been exposed (internally or externally) to any of the following?
Please circle (YES/NO) as applicable and provide details below

Biohazards YES NO

Biological agents YES NO

Hazardous chemicals YES NO

Radioactive substances YES NO

Other hazards YES NO

Please provide details of any hazardous materials used with this equipment as indicated above (use continuation sheet 
if necessary)

Your method of cleaning/decontamination

Has the equipment been cleaned and decontaminated? YES NOT NECESSARY

Michell Instruments will not accept instruments that have been exposed to toxins, radio-activity or bio-hazardous 

Work will not be carried out on any unit that does not have a completed decontamination declaration.

Decontamination Declaration
I declare that the information above is true and complete to the best of my knowledge, and it is safe for Michell 
personnel to service or repair the returned instrument.

Name (Print) Position

Signature Date
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